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Through the years, I have come to know Vincent Versace fairly 
well. We have travelled to foreign lands together and share 
memories of many good times. I have found that no matter 
what the subject of conversation is, he has an opinion. He can 
be funny, sarcastic, and irreverent, but steer the topic towards 
photography and art and a different Vincent Versace presents 
himself. He becomes serious and focused. The subject touches 
a nerve deep within the soul of this man, and Vincent be-
comes immersed in a passion that easily becomes contagious.

Vincent is a great photographer, but a better description 
would be—Artist. Give the average couch potato with little 
drive or ambition the most complete set of brushes, paints, 
and canvases that money can buy, and what will you get in re-
turn? Not much. Give an artist a worn piece of chalk and what 
will you get? You will get something that will capture your 
soul. Vincent does not just take a picture, he feels the image. 
It is obvious when looking at his work that, once he has been 
inspired, he will go to great lengths to perfect the end result 
so that it will then inspire you. 

Vincent is a talented and gifted artist, but his greatest  
talent and gift is his ability and desire to teach. It is this side 
of the man that makes this book such an important piece 
of work. 

Vision is something that lies within all of us. We all 
possess the ability to be creative. Whether we pursue this 
creative instinct is a matter of personal choice. There is a 
rewarding warmth that comforts the soul once you have 
been inspired and then create something tangible that can be 
shared with others. In this book, Vinnie teaches you how to 
transcend the limitations of the photographic medium that 
keep you from realizing your vision. He teaches you how to 
create the mood through proper lighting. He shows you how 

Foreword

to combine multiple images to create that single, perfect shot. 
Vincent clearly holds your hand through all the processes 
necessary to bring your vision to life.

He does this in a way that is highly informative yet easy 
to understand. You might say it is even entertaining. Vincent 
riddles the chapters with little insights and bits of infor-
mation that help you completely grasp the concepts being 
discussed. Whether the subject is setting up a reflector or 
combining multiple HDR images, you walk away with the 
satisfaction of successfully having added a new set of skills to 
your repertoire.

Each subject is tackled with the same passionate intensity 
that Vincent Versace employs in the creation of his work. No 
stone is left unturned. You get every side of the story. You get 
all the tools you need to do whatever your creative imagina-
tion can conjure.

The camera and Photoshop, in the hands of an artist, go 
far beyond that “worn piece of chalk.” We live in a world that 
has become a media frenzy. We can’t walk down the street or 
pick up a magazine without being bombarded with tons of 
chaotic imagery, a plethora of images all fighting for atten-
tion to sell you this or that—a dizzying array of colors, styles, 
and subjects that can make you scream! Every now and then 
something stands out. Something catches your eye and says, 

“Look at me for a while.” What is it about that “something” 
that makes it different? More often than not it is the fact that 
the person who created the work had more in mind than just 
grabbing your attention. They wanted to reach out and touch 
you—not just capture your attention but hold it for a while. 
Whether the intent is to soothe you or excite you into action, 
how that image has been presented makes all the difference 
in the world.
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Take, for example, the fact that there are millions of pic-
tures of flowers out there. What makes one stand out above 
the rest? Is it the color? Is it the composition? Is it the sur-
roundings? It is all of these things and more. It is the emotion 
that the flower stirred in the person at the moment of cap-
ture. It is how well that person was able to convey that emo-
tion via their image. It is the passion and hard work that the 
person put into making that final image to share with others. 
It is the eye and skill of the artist.

This book will train you to see the world through the wide 
open eyes of an artist. It will then give you the skills that you 
need to take what your eyes see and convert it into a work of 
art for the rest of us to enjoy. The skills go far beyond those 
taught in other books of this genre. Many Photoshop books 
will teach you what the tools do, but how many teach you 
when and why to use them?

What do you look for? What does that shot need to 
make it terrific? How do you plan your workflow? Sound 
overwhelming? Vincent holds your hand through the entire 
process. He challenges you while comforting you at the same 
time. He gives you the means to do great work. All you need 
to do is read this book and feel the passion and desire to be an 
artist. Sound easy? No! It is not. But, if you are up to the chal-
lenge, if you feel that burning desire to be the best you can be, 
this book is your ultimate weapon. If you think you are pretty 
good at what you do, here is your chance to be great.

Learn from a true master of the art. The rest is up to you.

—Bert Monroy
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If we have learned one thing from the history of invention and 
discovery, it is that, in the long run—and often in the short one—
the most daring prophecies seem laughably conservative.

The only way to discover the limits of the possible is to go beyond 
them into the impossible.

—Arthur C. Clarke

Look at the image to your left and turn the book upside down.
Frequently in photography, as is the case in life, things are 

not what they appear to be. 
When I was asked to revise this book, I decided that, rather 

than just update the keyboard commands and add a few of 
the new bells and whistles from CS5 and call it at day, it would 
be better to practice what I preach, which is that practice does 
not make perfect. Perfect practice makes perfect. So this book 
is not a revision. It is a complete re-write. The approach that 
I took when re-writing was to tell you what I would do today, 
this moment, with these images, as if I were working on them 
for the first time. I also felt it important to use a new image, 
shot with the largest file that I can produce, and show you a 
large megapixel workflow.

This book is about understanding the middle, the process 
of producing an image; what you should consider at the point 
of capture to create the very best print. For me, this is what 
the technical aspect of photography is all about. 

One of the first changes you might notice in this book, is 
that two complete chapters are absent: the black and white 
chapter, and the chapter on time. Also, the book is 100 pages 
longer. 

Just Like the Movies: The Pre-Show Entertainment

This book is now the first book in what will be a three,  
possibly four, book series, the first being Welcome to Oz 2.0: A 
Cinematic Approach to Digital Still Photography with Photoshop; 
the second, From Oz to Kansas: Almost Every Black and White 
Conversion Technique Known to Man (an expansion of the 
original black and white chapter into its own book); the third, 
Return to Oz (which will contain the chapter on time and will 
explore the conceptual difference between photographing the 
movement of time versus the motion of time); and the last 
book (should I live this long), Every Picture Tells a Story: Cin-
ematic Digital Still Photography and 21st Century Composition 
Theory.

This book is not about how you can make my pretty pic-
tures, it is about learning techniques that I believe will help 
you make your pretty pictures a closer reflection of the voice 
inside you. I want you to be able to make your own images, 
not just make a Xerox of mine.

The conversation that I want to begin with you in this 
first book of the Oz series is one concerning being taken by 
a photograph; to be so compelled by the image that you see 
in the viewfinder, to be so completely committed to the mo-
ment, that you do not take the image, the image takes you. 
Those are images that took your breath from you. It was that 
moment that made you want to convey that feeling to others. 
This book is about starting that journey.
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Sometimes you read a book and you understand it, and sometimes you 
read a book and it understands you.

—Bjork

In the past, when I bought “how-to” books, I bought them by 
weight. The equation was a simple one: I assumed that the 
heavier the book, the more knowledge it contained. Over the 
years I accumulated lots of answers; I just did not know any 
of the questions. I had the how, but no idea of the why. What 
I have discovered is that the why is more important than the 
how. If you know what you want to do and why you want to 
do it, discovering how becomes mere detail.

This book is not intended to teach you how Photoshop 
works, nor does it offer a “12-steps-to-perfect-photos,” one-
size-fits-all workflow. Rather, this book is about engaging in 
a conversation that will lead to teaching yourself to be able to 
make magic, starting at the point of capture. There is a circu-
larness to photography. Because you are in service of the print 
(the end) which is your voice, the more you know about image 
editing (the middle), the more informed your decisions can 
be when you make your captures (the beginning). We will be 
traveling in a circle, but we will be doing it in a straight line.

This is a book about exploring how to express your vi-
sion. No one can teach you how to become an artist. Art, and 
being called an artist, are social terms. You do not create art 
by deciding that is what you are going to do today, and you 
do not become an artist by proclaiming yourself one. In my 
eyes, nothing I do is art. For me, it is expression. It becomes 
art when other people call it so. In the moment that “art” hap-
pens for the viewer of my work, I am an artist. 

It is of ultimate importance that you create only those 
images that you find worthy. Others cannot like what you 
do not. I know that my harshest critic sits in the same chair I 
do. I offer you this thought—there are enough people in the 
world who want to beat you up; do not help them. Create im-
ages that please you. If you think you have an image with un-
fulfilled potential, do not discard it as worthless. Determine 
what about the image should be different and then transform 
it so it becomes an expression of your voice.

The experience that this book is designed to create is one 
that mimics, as closely as possible, the real-world experience 
of image editing. To this end, included with this book, you 
have received full-resolution, 16-bit source files (not 72-dot-
per-inch low-resolution work files) on which to work. Addi-
tionally, there is a 100-ppi version of the source file that was 
created during the writing of each chapter’s lesson, so that 
you can see what these files look like in your environment, 
that is, on your calibrated monitor on your computer. I as-
sume nothing other than that you believe that the journey is 
the destination. 

What digital photography has shown me is that impossible 
is just an opinion. For the first time in my creative life, I can 
realize my vision and express it for others to see. This is the 
journey on which I wish to take you. It is the reason that I 
wrote this book. 

The More Things Change, the More They Remain  
the Same: Mostly the Original Introduction
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The Core Concepts of a Cinematic  
Approach to Digital Still Photography

NoTe: This core concept was originally taught to me by Eric 
Magnusson, and it is one that we will revisit a number of 
times in this book .

There are two “eyes” that view an image, the uncon-
scious eye and the conscious eye . The unconscious eye is 
an amazing biological optical system that “sees” in a predict-
able manner. By controlling how the unconscious eye moves 
across an image, you can determine the story that the con-
scious eye perceives. 

If something you see moves you, take a picture of 
it . Do not hesitate. If you hesitate, the moment is lost. The 
moments of life happen, they do not re-happen. Viola Spolin 
said, “In absolute spontaneity, you get absolute truth. You can 
only be one way when you are spontaneous, and that’s truth-
ful.” By staying in the moment and allowing the spontaneity 
of your experience to cause the shutter to be fired, all of your 
images will have in them the truth of what you felt and saw. If 
you preconceive what you are going to shoot, the images lose 
that truth, that reality. 

Visualize the finished image in your mind’s eye as you 
are taking the picture and not a moment before . You do 
this so that when you get to the image editing process, you 
already have the end in mind. When you approach shoot-
ing images this way, you can remove everything that is not 
your vision. But even though you want to hold a clear vision 
of what you want the image to be, do not start with precon-
ceptions about what you are going to shoot. Walk into the 
taking of pictures open to what is out there, without any 
preconceptions.

Get it right in the camera . If it does not look good 
through the lens, it will not look good coming out of the 
printer. Even if you find yourself in a situation that does not 

Though this book’s entire focus is on the why and how of 
developing a cinematic approach to digital still photography 
with Photoshop, what follows are the core concepts that are 
the foundation of this approach.

Photoshop is not a verb . It is a noun. It is the means to 
an end, not the end itself. Photoshop is not the reason you 
take a picture, it is a tool to help you realize your vision. Pho-
toshop, though one of the most inspired pieces of software 
ever written, was not meant to be used as a jackhammer; it 
was intended to be used as an emery board. Should you ever 
be asked whether or not you altered an image in Photoshop, 
you want it to be a question, not an accusation.

 A still photograph is called a still photograph because 
the picture does not move, not because the objects in the 
picture are not in motion . This is the single most important 
consideration when taking a photograph. What occurs in a 
properly executed still photograph is that motion is captured 
with stillness. If we were to take a 35mm movie camera, place 
a flower that was just beginning to bud in front of it, let the 
movie camera fire off one frame a minute for two weeks while 
the flower blossomed, develop the film, and play what we 
shot at 28 frames per second, we would see the flower open 
up before our eyes and then the petals drop off. At no time 
did the flower stop moving; what was stopped was the mo-
tion of the flower. Things happen at the speed of life. They do 
not happen at one frame a second or even 8.5 or 28 frames a 
second.

RGB is not a color . RGB is a formula to mix color . If you 
can see it with your eye, it is a color. How you control color is 
one of the elements that will determine how the viewer’s eye 
moves across a print. From the moment of capture, under-
standing the formula to mix color will make your images more 
successful when they are printed. 
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allow you to make the captures as you would have liked, get 
as much right in camera as you can. Make informed decisions 
as you shoot, keeping in mind what images you might need 
when you get to image editing in Photoshop, so that your 
choices are not compromises.

Compose your images, do not crop them . Cinematog-
raphers do not have the luxury of cropping an image in the 
darkroom or the computer. What they see in the viewfinder 
is the canvas on which they have to paint. You are responsible 
for every millimeter of every image frame you create. Fill it! 
Place your subject in places other than the center of the frame. 
Bulls-eye composition is great if you are a marksman, but in 
the creation of a photograph, it is generally not considered to 
be a preferable style choice. 

Workflow starts at the point of capturing the image 
and is dynamic, not static . No two images are the same, 
therefore no two workflows are the same. Be adaptive. Always 
pro-act, do not react. Be willing to improvise, and you will 
find the impossible within your reach. 

In the ensuing chapters, just a few of the subjects we will 
explore are: light, gesture, shape, color, and the formula to 
mix color. It is my hope that when you arrive at the last word 
of the last chapter in this book, you will have attained the 
same skill set as I have. Your vision is not limited by your 
skills—only by your imagination. Your skills help you to com-
municate your vision to others. With that said, we begin.



Figure 4.0.2 After

Figure 4.0.1 Before



Light, gesture, and color are the key components of any photograph.  
Light and color are obvious, but it is gesture that is the most important.  

There is gesture in everything. It’s up to you to find the gesture that is most telling.

—Jay Maisel

Chapter 4

The Unwitting Ally 2 .0
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On Light, Color, Shape,  
and Gesture
The late painter and designer Josef Albers said that “shape is 
the enemy of color.” By that he meant that when shape is in 
the presence of color, we tend to remember the shape and not 
the color. But if you understand how to control color—regard-
less of whether the photograph is color or black and white—
you will have complete mastery of the images you create. The 
key is to find a way to cause shape to become color’s unwit-
ting ally, and thereby make color a shape that the viewer will 
remember.

This is easier said than done, of course. What you need is a 
catalyst to make shape and color work in harmony. And this is 
where pattern comes in.

Patterns are shapes we tend to see in things, sometimes 
when they are not really there. Patterns tend to manifest 
themselves as shapes. Whether it is light coming through tree 
leaves, a paper bag in a subway trash can, or raindrops on a 
windshield, everything can form or be perceived as a pattern. 
Patterns are interesting, but a pattern interrupted is more 

The concepts behind this lesson are the outcome of conversa-
tions that I have had over the years with two great photog-
raphers: Jay Maisel, who has forgotten more than I will ever 
know about light, gesture, and color, and who first introduced 
me to those concepts; and my uncle, photographer CJ Elfont, 
who taught me photography and, most importantly, how the 
eye “sees.” The writings and images of poet-photographer 
Ernst Haas have also strongly influenced me by teaching me 
how to allow the eye to see the feeling of the moments in 
my images; to be taken by the photograph rather than take 
the photograph. When you master this lesson, you will have 
grasped the heart of what I have discovered about how it all 
works. The real journey begins now.

In this chapter, you will go beyond exposure and apply the concepts of Extended Dynamic 
Range photography (ExDR) to focus, blur, and image structure by using image harvesting . 
You will apply this to the image editing process in order to support the aesthetic choices you 
make regarding light, shape, gesture, and color when you first take the picture . Picasso said, 
“Art is the lie that tells the truth .” With that in mind, you will also apply techniques to create 
an aesthetically satisfying final image rather than a historically accurate one . Additionally, 
you will use the approach introduced in Chapter 1, and expanded on in Chapters 2 and 3, to 
guide the viewer’s unconscious eye through the image . Finally, you will explore the changes in 
workflow that you need to make when working with large megapixel files . (The files for this 
lesson were captured with a Nikon D3x, which is a 24 .5MP camera .)
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interesting. If you interrupt a pattern, you are on the path to 
finding a way to use shape as the unwitting ally of color. 

Jay Maisel says that light and color are obvious, but it 
is gesture that is most important. In the photograph of my 
niece, the gesture is obvious. The pattern we recognize first is 
her face, and the finger stuck in her nose interrupts that pat-
tern (Figure 4 .0 .3). 

Here is an example of an image where gesture is not as 
plain as the nose on my niece’s face. Look at the image of the 
flower and the leaves, then look away (Figure 4 .0 .4). Which 
color do you remember? Most people will say magenta or 
red. Even though 90% of the image is made up of greens, you 
tend to remember the part with the most shape. The shape 
has become an unwitting ally of the color. The color is further 
reinforced because the magenta/red flower’s shape and cir-
cular pattern is interrupted by the linear pattern of the green 
blades. Further, the magenta flower appears to be moving 
away from the green blades, and this pattern holds the gesture 
that is most telling. 

Of light, gesture, and color, light is the most frequently 
taken for granted. You see it, it is there, end of story. But 
rather than merely accepting its presence, why not consider 
viewing it as an object? Treat it as if it were a solid and a part 
of the experience being expressed in the photograph.

Take, for example, these images from the original Seattle 
Sequence series (Figures 4 .0 .5, 4 .0 .6, 4 .0 .7, 4 .0 .8, 
4 .0 .9, and 4 .0 .10). The light tells the story of the moment in 
each image, whether black and white or color. (If you can see 
something, it has color. The artist Matisse said, “Black is the 
queen of all colors.”)

NoTe: The 12 images that are the original Seattle Sequence 
were shot in 45 minutes . My skill as a photographer had 
nothing to do with how quickly I shot; I had forgotten to 
charge the battery in my camera . I saw the charge eroding 
as I watched one of the prettiest displays of light that I have 
ever seen . Shafts of light broke through the clouds of a de-
parting rainstorm, while a new rainstorm was moving in . 

Figure 4.0.3 A universal gesture

Figure 4.0.4 Do you see the green or the magenta?
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Figure 4.0.5 Figure 4.0.6 Figure 4.0.8 Figure 4.0.9

Figure 4.0.10Figure 4.0.7
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In each instance, no matter how brief, I perceived the image 
in its final form as I photographed it, and that perception 
determined how I harvested the images. In each capture, the 
light informed the image, made the patterns and interrupted 
them. In each instance, light was as physical and tangible a 
thing as the flowers, and for each I considered (no matter how 
momentarily) how I would use dark, intermediate,  
and light isolates.

Using Dark and Light Isolates
The Isolate Theory, conceived by CJ Elfont, is a way of look-
ing at composition and explains the interrelationship of the 
elements (or isolates) in a photograph and how these can be 
used to evoke meaningful, emotional responses in viewers. 
(See the sidebar for a very brief overview of this theory.) This 
compositional theory formed the basis for how I see and re-
mains one of the cornerstones of my vision today.

In the next image of Calla lilies, the primary isolates are 
the two flowers that are slightly to the right of center. The 
gesture that is most telling is the spiral that starts from the 
upper right in the dark isolate. This is the darkest area in 
which there are definable structures, and it continues to the 
center of the photograph, where the primary light isolates 
exist. This particular pattern occurred by happenstance, but I 
reinforced it (Figures 4 .0 .11, 4 .0 .12, and 4 .0 .13). 

By using selective contrast and sharpness, I gradually 
created the dramatic effect of motion in a still image. I also 
interrupted the pattern of the background with the spiral of 
light-to-dark and, in this way, found the most telling gesture. 
All of this was already present in the image, but it had to be 
brought out; I had to remove from the file everything that 
was not my vision. 

If gesture is the expression of the photograph, and light is 
its language, then colors are its words, and contrast, satura-
tion, and sharpness are the alphabet. Without words and 
language, expression has no meaning. Without the alphabet, 
there are no words. 

Knowing that I had little time to record these images, fear 
became my caffeine, and I shot until my battery died . Among 
the images that came from those 45 minutes were 12 that 
I thought were particularly outstanding . The lessons that 
I learned were to just shoot the image—don’t think about 
shooting the image—and carry an extra battery .

Elfont’s Isolate Theory (A very brief version)

Isolate Theory explains the interrelationship of the 

elements (or isolates) in a photograph that results in 

an effective composition, i.e., one that communicates 

the photographer’s vision to the audience. The primary 

isolate(s) is the first element (either light or dark) in the 

composition to which the eye is drawn. Supporting isolates 

are different in density from the primary one(s), but they 

complement and enhance it. However, if there is more 

than one primary isolate, and they compete rather than 

maintain a continuity of line and form within the compo-

sition, then the viewer’s eye does not know where to go 

first. This results in a communication failure between the 

viewer and the image. The artist’s statement loses impact 

and the viewer becomes confused and loses interest. 

The viewer is first drawn to an image by the power of 

the primary isolate(s). Only after this do the supporting 

isolates come into play and the viewer begins to see and 

feel the nuances of the entire composition. Thus, a suc-

cessful composition gives the viewer something new to see 

and discover every time they return to the image. This is 

what makes for a meaningful composition that commu-

nicates with, and involves, the viewer on both a conscious 

and subconscious level.
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If the words of color are lost in a cacophony of shapes, 
the image will be less than it could be. The better you sup-
port color and its expression, the better your images will be 
appreciated. And just as in a street fight, the only rule is that 
there are no rules. Everything you do is in service of the print, 
which will always be in service of what is ultimately most im-
portant: your voice and vision. 

Seattle Sequence Re-Sequenced 
Stop taking pictures. Be taken by your pictures.

—Ernst Haas
In the first edition of this book, I used a series of images that 
I captured one morning at sunrise in Cades Cove (in the Great 
Smoky Mountains National Park). Without planning what I 
would shoot, I had gotten up extraordinarily early hoping to 
shoot in the fog at sunrise. I actually saw the field of flowers 
after all the fog had burned off and I was about to leave. I just 
found the images, or maybe they found me (Figure 4 .0 .14). 
With this set of images, I began to be aware of the difference 
between taking a picture and being taken by one. 

As I crawled around on my hands and knees among the flow-
ers in the dew, the light moved and changed. I tried to ap-
proach the light the same way I approached the flowers, as if 
it were a solid object. I made sure to get as many captures as 
I could using as many options as I could. Moments like those 
happen; you cannot make them re-happen.

If you look at the images that I shot, you can see the evolution 
of my vision as I experienced the flowers. It is in that journey 
that I discovered the destination.

For this rewriting of Welcome to Oz, I decided to change the 
image for this lesson so that I could go beyond using my first 
epiphany (or Eureka!) moment images in order to more deeply 
explore the concept of ExDR and how to manage the huge 
amounts of data and the large files that are generated when 
using high-megapixel DSLRs. 

Figure 4.0.12

Figure 4.0.13

Figure 4.0.11
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If you look at the images that I captured of the flow-
ers that were randomly placed in buckets in a crowded 
market (Figure 4 .0 .15), once again, you can see the evo-
lution of my vision as I experienced the flowers. Each 
was a part of the journey on which the flowers took me 
(Figures 4 .0 .16, 4 .0 .17 and 4 .0 .18).

Figure 4.0.14 Cades Cove flowers

Figure 4.0.15 Images captured of flowers in a bucket in a market

Figure 4.0.16 Figure 4.0.17

Figure 4.0.18
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The lessons to be learned using the images that make up this 
lesson are not just about the bokeh of the lens, they are also 
about using sharpness and defined image structures to se-
lectively extend the areas of focus in an image that is mostly 
about blur. 

If you look at the image as some photographers might shoot it 
and call it a day (_VAV072122_SHRP.tif), it is boring, but his-
torically accurate; something you might see on a seed packet. 
If you look at _VAV0722BASE_LITE.tif, it is a far more inter-
esting image due to the bokeh or blur. Though more visually 
appealing, it still does not realize the vision that I had when it 
took me. To recreate that vision, I needed an expanded expo-
sure range so that multiple areas, at different distances and at 
different levels of sharpness, were all in focus, while existing 
in a shallow DOF. As I discussed in the previous chapter, that 
cannot be achieved in one capture using a fixed optical/sensor 
plane system. To achieve the end that I had in mind for this 
image, I had to practice preemptive Photoshop and capture all 
of the image elements that I thought I might need to extend 
the dynamic range of each of them. Simply put: Real pixels are 
always preferable to computer-generated ones. 

Up to this point, you have been working with images that 
were captured with cameras that were no larger than 5.5 
megapixels. In this lesson, you will be working with images 
captured from a Nikon D3x, a 24.5 megapixel camera. You 
will see how to adapt your workflow to the needs of the file. 
A 24.5MP RAW file, when opened in 16-bit in the ProPhoto 
color space, is about 149 megabytes. This means that if you 
harvest four images, you will have a file that is almost 600 
megabytes before you do anything. 

Once you have chosen the images with which you want to 
work, you can begin making structural and aesthetic choices. 
(Because the fulfillment of your vision starts with the choices 
you make at the time of capture, you should let them guide 
you in choosing how and what to photograph. The more you 
get right in your captures, the better off you will be when you 
begin building the image in Photoshop.) 

Here are some initial considerations:

	 u	 You will need to align all the images, so that they will 
blend together as seamlessly as possible. 

	 u	 Because the lightness of the images differ, you must 
make aesthetic choices that you can accomplish with-
out leaving chalk marks. More specifically, do not make 
choices that require technical adjustments that will be 
obvious to the viewer once your work on the image  
is complete.

	 u	 Aesthetically, you want to support the image’s yellows 
rather than its greens. 

	 u	 The gesture of this image is the way the top of the flower 
wraps around the stem and flows downward to the right 
before tapering to the center bottom where it attaches to 
the stem. However, you want the viewer’s eye to travel in 
the opposite direction: from the lower right, up through 
the middle, to the flower embracing the stem, because it 
makes for a stronger visual journey and therefore a more 
successful image. This movement should be repeated as 
long as the viewer is looking at the image (hang time). 
You will use sharpness, contrast, saturation, and focus to 
cause the viewer’s eye to travel through the image along a 
path you create, and you want to use blur to give the eye 
a place to which it can retreat.
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Creating a Single Image

Disregard for details is the first sign of doom.
—Kai Krause

Step 1: Many Parts to Assemble the Whole 
As in the previous chapters, you will approach the creation of 
this image going from global to granular. The following steps 
will show you how I removed everything that was not my vi-
sion from the Seattle Sequence 2.0 flower images and how 
I practiced preemptive Photoshop at the point of capture. I 
chose the lens I used for its bokeh, because, in my vision of 
this image, it is the quality of the blur in relationship to the 
area(s) of focus that I find aesthetically appealing. 

1. Open these three files:

 _VAV0719BASE_DRK.tif

 _VAV0722BASE_LITE.tif

 _VAV072122_SHRP.tif 

2. Starting with the file _VAV0722BASE_LITE.tif, double-click 
on the icon of the image in the Layers panel. (It should say 
“background” when the Layer dialog box comes up.) Name 
this layer BASE_LITE which unlocks it—something that needs 
to be done before you align all of the layers. 

3. When you select Save As, create a new folder (located in 
the lower, left corner of the Save As dialog box) and name the 
folder SEATTLE_LILY. Now, rename the 
_VAV0722BASE_LITE.tif file SEATTLE_LILY_16bit, and save it 
as a Large File Format (.psb). (This is located in the Format 
pull-down menu in the Save As dialog box and is the second 
option just below Photoshop Document.)

NoTe: You should save the file as a  .psb file rather than in a 
Photoshop Document format ( .psd) because the .psd file size 
is limited to two gigabytes . A  .psb file, on the other hand, 
does not suffer from this size limitation .

4. Duplicate this file, and rename it 
SEATTLE_LILY_ALIGN_16bit.

5. Once you have saved the file, create a layer group, and 
name it ALIGNED_PARTS.

6. Click on the _VAV0719BASE_DRK.tif, making it the active 
file. Click on the BACKGROUND layer of this file and, holding 
down the Shift key, drag the background layer to the destina-
tion file, SEATTLE_LILY_16bit.psb. Name the newly created 
layer BASE_DRK. Do the same with _VAV072122_SHRP.tif and 
rename this new layer SHRP_DRK. Once you have placed all of 
the files into the SEATTLE_LILY_ALIGN_16bit file, close them. 
You should have two files open,  
SEATTLE_LILY_ALIGN_16bit.psb and SEATTLE_LILY_16bit.psb. 
The layer order in the ALIGN_PARTS layer group in the SEAT-
TLE_LILY_ALIGN_16bit file should be BASE_LITE, BASE_DRK, 
and SHRP_DRK.

7. Save the file.
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Step 2: Creating a Lighter Version  
of a Darker Flower
In this step, you will use Match Color to make a lighter ver-
sion of a layer. It would have been lighter had I done this in 
the camera, but while I was shooting this part of the harvest, 
the clouds moved, changing the lighting. Normally, when I am 
working this way, once I have established focus, I do things in 
manual mode, which affords me greater control over exposure 
and DOF. The trade off is that the camera cannot automati-
cally readjust exposure for changes in light. So even though I 
wanted a brighter image, I did not get it. Using Match Color is 
one way to match both the color and the brightness of one file 
to another. There is a caveat—when the Match Color adjust-
ment works, it works really well, and when it does not, it is 
useless. Match Color works best when you harvest images of 
the same thing at the same location. It might not work if you 
try matching color from two different locations and/or of two 
different objects. 

1. Duplicate the SHRP_DRK layer (Command + J / Control + J).

2. Rename this newly duplicated layer (which Photoshop will 
have automatically named SHRP_DRK copy) to SHRP_LITE. 

3. Make SHRP_LITE the active layer, and go to Image > 
Adjustments  > Match Color (Figure 4 .2 .1).

4. In the Source pull-down menu, select SEATTLE_LILY_
ALIGN_16bit and, in the Layer pull–down menu, select BASE_
LITE (Figures 4 .2 .2 and 4 .2 .3).

5. The image is brighter, but not quite enough. In the Op-
tions part of the Match Color dialog box, move the Lumi-
nance slider to the right to 133, and move the Color Intensity 
slider to the right to 115. 

6. Click OK. 

Compare the image before the Color Match adjust-
ment (Figure 4 .2 .4), after the Color Match adjustment  
(Figure 4 .2 .5), and after the Luminace and Color Intensity 
increases (Figure 4 .2 .6).

Figure 4.2.1

Figure 4.2.2 Selecting SEATTLE_LILLY_
ALIGN_16bit. in the Source pull-down

Figure 4.2.3 Selecting BASE_LITE in the 
Layer pull-down
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NoTe: These choices were made because you want the 
viewer’s unconscious eye to go first to the flower and to see 
the yellows before the greens . Because the eye first goes 
from light to dark, you lightened up the layer that contained 
the most defined image structures . However, you had to 
increase the color intensity because when you lighten an 
image, color saturation decreases . Conversely, when you 
darken an image, color saturation increases . 

7. Save the file.

Step 3: Aligning the Almost Aligned
No matter how good your tripod, tripod head, and camera 
fastening system, whenever you touch the camera during the 
capture process, even to refocus, you introduce some form of 
camera movement. This next step addresses this first part of 
the alignment problem.

I have observed that when using the Auto Align Layers feature 
in Photoshop CS5, the order of the layers in the layer stack 
and which layer you click on first (top or bottom) has an effect 
on how the layers will be aligned. Therefore, you must decide 
which is the primary layer (the BASE_LITE layer is the primary 
layer in this image) and make sure it is at the top of the  
layer stack. 

1. Click on the BASE_LITE layer and make it active. Holding 
down the Shift key, click on the SHRP_LITE layer. This will 
make all of the layers between the two active.

2. Go to Edit > Auto Align Layers. For the Projection,  select 
Auto. Generally, this one works best. Click OK.

Figure 4.2.4 Before the Color 
Match adjustment

Figure 4.2.5 After the Color Match 
Adjustment

Figure 4.2.6 After the Luminance and Color Intensity 
increases
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You will notice that the alignment process has resulted in an 
image that is no longer full frame (Figure 4 .3 .1). You could 
crop the open areas, but that would change the image, and 
perhaps risk losing parts of it. This next step addresses this 
second part of the alignment problem. 

3. Holding down the Shift key, click on the ALIGNED_PARTS 
layer group and drag it to the SEATTLE_LILY_16bit file.

4. Save the SEATTLE_LILY_16bit.psb file.

5. Close and do not save the SEATTLE_LILY_ALIGN_16bit.psb 
file. 

NoTe: You are not saving this file so that you give yourself 
an exit strategy . Because the aligned layers are now in the 
SEATTLE_LILY_16bit .psb file, there is no need to have two 
copies of them . Should you feel the need to re-align the lay-
ers later, you have a file that is already set up for that in 
which the layers are not aligned . 

Step 4: The Sum is Greater Than the Parts: 
Creating one Image from Four Layers
In this step, you will not only extend the range of exposure, 
you will also extend the range of the sharpness and blur. I 
have found that real pixels are always better to use than at-
tenuated ones. By using pixels unmodified in Photoshop, you 
reduce the amount of overall artifacting. You can also control 
the amount of detail in any specific area. Essentially, you can 
have your blur and see the image, too. In the first part of this 
next step, you will add dark, and in the second part, you will 
add light and sharpness.

All the decisions that you make from this point forward are 
about how the viewer’s eye will move through the image, how 
to reinforce the gesture of the image, and how to cause shape 
to become the unwitting ally of color. 

You will begin by making sure that the viewer sees the yellows 
before the greens, so that their unconscious eye moves from 
the lower left of the image to the center, then to the upper 
part of the flower where the top of the lily intertwines with 
the stem, and then to the top of the lily that goes out of the 
frame. 

Adding Dark 

1. You have two layers named BASE_LITE: one inside the 
ALIGNED_PARTS layer group, and one outside it. Rename the 
BASE_LITE layer in the ALIGNED_PARTS layer group BASE_
LITE_M (for Base Lite Modified). This is the image map for the 
BASE_DRK layer (Figure 4 .4 .1). 

2. In the ALIGNED_PARTS layer group, turn off all the lay-
ers except BASE_DRK and make it the active one. You should 
now have the BASE_LITE layer turned on (the one outside the 
layer group) and the BASE_DRK layer (the one inside the layer 
group) turned on.

3. Add a layer mask to the BASE_DRK layer and leave it 
white.

4. Select the Brush tool (B), make the foreground color black Figure 4.3.1 After the alignment, the image is not 
full frame
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and the background white, set the brush opacity to 100% and 
the width to 400 pixels, and brush in the entire flower and 
the area inside the stem. View the layer mask (Figure 4 .4 .2), 
and compare the images before (Figure 4 .4 .3) and after the 
brushwork (Figure 4 .4 .4).

5. With the foreground color black and the background 
white, and a brush opacity of 50% and a width of 250 pixels, 
brush in the entire stem next to the flower. Bring up the Fade 
effect dialog box and move the slider right to 74%. Brush in 
the back part of the flower at 50%. Bring up the Fade effect 
dialog box and move the slider left to 44%. View the layer 
mask (Figure 4 .4 .5) and the image after the brushwork 
(Figure 4 .4 .6).

Figure 4.4.1 The image map

Figure 4.4.3 Before brushwork

Figure 4.4.2 The layer mask

Figure 4.4.4 After brushwork Figure 4.4.5 The layer mask Figure 4.4.6 After more brushwork
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6. With the foreground color black and the background 
white, and a brush opacity of 50% and a width of 600 pixels, 
brush in the entire area to the lower right of the flower. Bring 
up the Fade effect dialog box and move the slider left to 34%. 
View the layer mask (Figure 4 .4 .7) and the image after the 
brushwork (Figure 4 .4 .8).

7. With the foreground color black and the background 
white, and a brush opacity of 50% and a width of 600 pixels, 
brush in the two stalk areas above the leaf on the right side 
of the image. Do one first, then bring up the Fade effect dia-
log box and move the slider left until the adjustment is most 
visually appealing, which for this image is at 47%. Then do 
the second and move the slider left to 47% as well. (They 
both require the same setting because you want both stalks 
to match. The Fade effect tool allows you to address only the 
last thing that you did, so you can do only one thing at a time; 
it’s the same type of adjustment that you made in Chapter 1 
when brushing in Challen’s eyes.) In the lower left corner of 
the image, brush in the lower corner to the left of the stem, 
bring up the Fade effect dialog box and lower that opacity to 
47%. View the layer mask (Figure 4 .4 .9) and the image after 
the brushwork (Figure 4 .4 .10).

8. Save the file.

Adding Light and Sharpness and More Dark 

What you have done thus far is to manually extend the dy-
namic range of the dark aspect of this image without using 
tone mapping software. Also, you used real pixels created at 
the point of capture to darken the image. This approach leads 
to more realistic looking colors and shadows, and you did not 
introduce the potential artifacts and color shifts that can re-
sult from using Curves and Levels adjustment layers. 

In the first part of this step, you created an image that is all 
about the bokeh or the quality of the blur of the lens that 
created it. In the next steps, you will selectively add lightness 
to extend the dynamic range of the exposure even further. 
You will accomplish this using the layer on which you did the 

Figure 4.4.7 The layer mask

Figure 4.4.9 The layer mask

Figure 4.4.8 After more brushwork

Figure 4.4.10 After more brushwork
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Match Color adjustment. Specifically, you are going to add 
sharpness from an image that was shot at a greater DOF. (In 
Step 2 of this lesson, Creating a Lighter Version of a Darker 
Flower, you matched the color and brightness of that image to 
the present one.) You will also add sharpness from the origi-
nal image (before you applied the Match Color adjustment) 
that was captured at about the same exposure level as the 
BASE_DRK layer that you have just brushed in. 

Here are the image maps for the three things that you 
will be doing to this image: The Sharpen Lite image 
map (Figure 4 .4 .11), the Sharpen Dark image map 
(Figure 4 .4 .12), and the Lily Tip Sharp image map 
(Figure 4 .4 .13).

Figure 4.4.11 The Sharpen Lite image map

Figure 4.4.12 The Sharpen Dark image map

Figure 4.4.13 The Lily Tip Sharp image map
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1. Make the SHRP_LITE layer active.

2. Select the Marquee tool, make a selection of the lily leaf 
tip (Figure 4 .4 .14), copy it to its own layer (Command  + J 
/ Control + J) and name that layer TIP_SHRP_LITE. Create a 
layer mask and fill it with black. 

3. Make the SHRP_LITE layer active, create a layer mask, and 
fill it with black. With the foreground color white and the 
background black, brush in the area of the front part of the 
lily with a brush opacity of 100% and a width of 600 pixels. 

4. Set the opacity to 50% and brush in the lily’s stem. 
Bring up the Fade effect dialog box and lower the effect 
to 22% by moving the slider to the left. View the layer 
mask (Figure 4 .4 .15) and the image after the brushwork 
(Figure 4 .4 .16).

5. Make the SHRP_DRK layer active, create a layer mask, 
and fill it with black. With the opacity still set to 50%, and the 
foreground color white and the background black, brush in 
the back part of the lily. View the layer mask (Figure 4 .4 .17) 
and the image after the brushwork (Figure 4 .4 .18).

Figure 4.4.14 The selected area

Figure 4.4.15 The layer mask on 
SHRP_LITE

Figure 4.4.17 The layer mask on 
SHRP_DRK

Figure 4.4.16 After brushwork on 
SHRP_LITE

Figure 4.4.18 After the brushwork 
on SHRP_DRK
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6. Make the TIP_SHRP_LITE layer active. Making sure that 
the layer mask is also active, zoom in to the tip area. Make 
the brush opacity 100% and the brush size 40 pixels. Brush 
in just the tip. View the layer mask (Figure 4 .4 .19) and the 
image after the brushwork (Figure 4 .4 .20).

Figure 4.4.19 The layer mask on 
TIP_SHRP_LITE

Figure 4.4.20 After the brushwork 
on TIP_SHRP_LITE

Breaking the 11th Commandment…  Yet Again

In the lower left corner of the image, there is an area of light 
that pulls the eye’s focus away from the flower. To address 
this issue, you will first use a clipped curve that you will also 
darken. Here is the image map for the Darken and Lowered 
Contrast adjustment layer (Figure 4 .4 .21). 

1. Create a Curves adjustment layer, and if it is not already, 
put it in the Fine Grid mode (Option- / Alt- click on the grid 
in the Curves dialog box). Lower the top handle of the curve 
six grid points. Click on the center handle and move it so that 
it is on the first and second grid line from the bottom. The 
output should read about 107 (Figure 4 .4 .22).

Figure 4.4.21 Image map for the Darken and 
Lowered Contrast Curves adjustment layer

Figure 4.4.22
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2. Fill the layer mask with black, and with the foreground 
white, select the Brush tool. Set the opacity to 50% and the 
brush width to 400 pixels. Brush in the area from below the 
bottom of the upper part of the left side of the lily (between 
the two stems) up to the stem that crosses the bottom of the 
lower left corner. Then re-brush over the brightest part of 
the area on which you just did brush work. (Remember that 
since 50% of 50% is 25%, you have just re-brushed this area at 
75%.) Now, brush the stem in the lower left corner, bring up 
the Fade effect dialog box, and reduce the amount by moving 
the slider to 25%. View the layer mask (Figure 4 .4 .23) and 
the image after the brushwork (Figure 4 .4 .24).

3. Click on the ALIGNED_PARTS layer group, create a master 
layer, and name it MASTER_1.

4. Save the file.

Step 5: The Registration Problem
You will notice that there is a light band that runs across the 
bottom of the image. This occurred during the alignment pro-
cess. Also, there may be some parts of the aligned image that 
may fall outside the canvas of the original BASE_LITE image 
(the image onto which you dragged the ALIGNED_PARTS layer 
group). In this step, you will address both issues.

1. Select the Crop tool (C) and drag it from the top left cor-
ner to the lower right one so that the entire image is within 
the Crop box (Figure 4 .5 .1).

2. Press the Return or Enter key to accept the crop. 

3. When the Crop processing has finished, make the MAS-
TER_1 layer active, and zoom in to the lower left corner of the 
image.

4. Select the Marquee tool (M), then click and drag the mar-
quee selection so that it is slightly bigger than the light area 
at the bottom of the image. Drag it from the right to the left 
edge of the image.

5. Go to Edit > Fill and, in the Contents part of the Fill dia-
log box, from the Use pull-down menu, select Content Aware. 
Click OK.

6. Save the file.

NoTe: New to CS5 are Content Aware Fill and Content 
Aware Spot Healing . Both of these are implementations of 
PatchMatch technology . These algorithms work by copy-
ing multiple patches to stitch together from the surround-
ing background and fitting them inside the area of the fill 
selection or the area of the Spot Healing brush . This is an 
improvement over the old Spot Healing proximity match 
approach that used only one patch from the background . 
By stitching together multiple areas, you get a much more 
convincing and seamless patch . The PatchMatch algorithm 
works not only for small areas, but for large ones, as well, as 
you have just seen . 

Figure 4.4.24 After the brushworkFigure 4.4.23 The layer mask



Chapter Four: The Unwitting Ally 2.0          243

Step 6: Harvesting from Within
As I discussed earlier, a pattern is interesting, but a pattern 
interrupted is more interesting. Currently, the image on 
which you are working has a pattern of greens and yellows 
in the background with one area of pinkish red. You want to 
interrupt that pattern while reinforcing the yellows over the 
greens. And there are still light areas that need to be toned 
down so that they do not pull the unconscious eye away from 
the main focus of the image, the lily. For that, you need some 
darker shapes to conceal the lighter ones and then some 
red/pink shapes to interrupt the pattern of greens and yel-
lows. Simply darkening the image by using Curves would not 
accomplish this. Whatever you do, when you are finished 
with this next step, the image must look as if it was origi-
nally captured that way. To accomplish this, you will harvest 
image structures from within the image. Here are the image 
maps for the two things you are about to do. View the Stem 
Parts image map (Figure 4 .6 .1) and the Reds image map 
(Figure 4 .6 .2).

Figure 4.5.1

Figure 4.6.1 Stem Parts image map Figure 4.6.2 Reds image map
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1. Create a layer set and name it INNER_HARVEST.

2. Make the MASTER_1 layer active. With the Marquee tool 
(M), make a selection at the edge of the lower right corner 
that contains the reddish/pink area, and copy it to its own 
layer. Name this layer REDS. Drag REDS into the INNER_HAR-
VEST layer set (Figure 4 .6 .3).

3. Again, make the MASTER_1 layer active. With the Marquee 
tool (M), make a selection of the stem area below the front 
part of the lily and copy it to its own layer. Name this layer 
STEM_PART. Add a layer mask. Drag the STEM_PART into the 
INNER_HARVEST layer set. Duplicate the STEM_PART layer 
(Figure 4 .6 .4).

4. Turn off the STEM_PART copy layer (the one that you just 
created) and make the STEM_PART layer active.

5. Select the Move tool (V) and move the STEM_PART layer 
to the lower right corner (Figure 4 .6 .5).

6. Select Free Transform (Command + T / Control + T), click 
on the top, center control handle, and stretch the selection 
upward to just above the front part of the lily. Click Return / 
Enter (Figure 4 .6 .6).

7. Select the Brush tool. Fill the layer mask with black. With 
the foreground color set to white, set the brush opacity to 
50%, and brush in the right side of the image (as shown in the 
STEM_PART image map). Bring up the Fade effect dialog box 
and increase the amount by moving the slider to 71%. Com-
pare the image before the brushwork (Figure 4 .6 .7), and after 
the brushwork (Figure 4 .6 .8), and look at the resulting layer 
mask (Figure 4 .6 .9).

8. Copy the STEM_PART copy layer so that you have a new 
layer, STEM_PART copy 2. Turn on the STEM_PART copy 2 
layer. Select the Move tool (V) and move the STEM_PART copy 
2 layer to the upper right corner, above the lily and over the 
light area between the two stems (Figure 4 .6 .10).

Figure 4.6.3 Copying the lower 
right corner to its own layer

Figure 4.6.5 Moving the new 
STEM_PART layer to the lower right

Figure 4.6.4 Duplicating the 
stem area

Figure 4.6.6 Stretching the selec-
tion upwards
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9. Select Free Transform (Command + T / Control + T). 
Holding down the Option / Alt key, click on the left, center 
control handle and expand the selection to the left. Click  
Return / Enter (Figure 4 .6 .11). 

10. Select the Brush tool and fill the layer mask with black. 
With the foreground color set to white, set the brush opac-
ity to 50% and the brush width to 400 pixels. Brush in the 
upper right side of the image (as shown in the STEM_PART 
image map) leaving the slider set to 50%. View the image after 
the brushwork (Figure 4 .6 .12) and the resulting layer mask 
(Figure 4 .6 .13).

Figure 4.6.7 Before brushwork

Figure 4.6.11 Expanding the 
selection left

Figure 4.6.13 The layer mask

Figure 4.6.9 The layer mask

Figure 4.6.8 After brushwork

Figure 4.6.12 After the 
brushwork

Figure 4.6.10 Adding STEM_
PART copy 2 above the lily
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11. Turn on and make the STEM_PART copy layer active, and 
move it so that it is over the bright area in the left corner of 
the image (Figure 4 .6 .14).

12. Select Free Transform (Command + T / Control + T) and 
move the curser to the lower handle. When the rotation ar-
rows appear, click and drag it to the right, and holding down 
the Option / Alt key, click on the left, center control handle. 
Expand the selection as you move it to the left. Click Return / 
Enter (Figure 4 .6 .15). 

13. Select the Brush tool. Fill the layer mask with black. With 
the foreground color set to white, set the brush opacity to 
50% and its width to 250 pixels. Brush in the light area in the 
lower left corner (as shown in the STEM_PART image map). 
Bring up the Fade effect dialog box and move the slider to 
86%. View the image after the brushwork (Figure 4 .6 .16) and 
the resulting layer mask (Figure 4 .6 .17).

14. Save the file.

Getting the Red In

You should now have an image in which the central focus is 
the lily. There should be no light areas to pull the eye away 
from that. You have used both image structures and colors 
that were inherent in the image. In this next step, you will 
add reds into the image to interrupt the pattern of the greens 
and yellows in the background, and to introduce visual depth. 
By introducing red elements, I think that all the aspects of 
the image become more appealing, which means that the 
viewer will look at it longer. Look again at the Reds image map 
(Figure 4 .6 .2).

1. Turn on, and make the REDS layer active. Select the Move 
tool (V) and move it to the center of the image. 

2. Duplicate the REDS layer twice.

3. Flip the REDS layer copy 2, horizontally (Edit > Transform 
> Flip Horizontal). Move the layer that you just flipped to the 
right (Figure 4 .6 .18).

Figure 4.6.14 Adding the STEM_
PART to the bright area on the left

Figure 4.6.16 The image after the 
brushwork

Figure 4.6.15 Transforming the 
selection

Figure 4.6.17 The resulting layer 
mask
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4. With the Move tool selected (V), click the left arrow key 
until the two layers overlap (Figure 4 .6 .19).

5. Merge this layer to the layer below it (Command + E / 
Control + E). 

6. Select the Spot Healing tool from the Tool options bar and 
select Content Aware. Make sure the Sample All Layers check-
box is turned off (Figure 4 .6 .20).

7. With a brush width of 70 pixels, and holding down 
the Shift key (this locks the brush so that it will move in 
a straight line), start at the top of the pink area and drag 
the brush down to bottom of the pink area. Then release it 
(Figures 4 .6 .21 and 4 .6 .22).

8. Name this layer REDS_DUO and add a layer mask to it.

9. Duplicate the layer (the new layer will be named REDS_
DUO copy), and move it to the upper right corner above the 
lily between the two stems. Turn off the REDS_DUO and 
REDS layers (Figure 4 .6 .23).

Figure 4.6.2 The Reds image map

Figures 4.6.21 and 4.6.22 
Brushing in the gap to correct it and 
the result

Figure 4.6.19 Aligning the two 
new layers with the Move tool

Figure 4.6.20 Selecting Content-Aware and turning off Sample 
All Layers

Figure 4.6.18 Duplicating the 
REDS layer twice and flipping the 
REDS layer copy 2

Figure 4.6.23 Moving the REDS_
DUO above the lily
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10. Select Free Transform (Command + T / Control + T) 
and, holding down the Option / Alt key, click on the left 
control handle and expand the size. Click near the lower, 
left handle, which will bring up the Rotate arrows, and ro-
tate the image slightly clockwise to match the angle of the 
two stems that border this selection. Press Return / Enter 
(Figures 4 .6 .24, 4 .6 .25, 4 .6 .26, and 4 .6 .27).

11. Make the layer mask active and fill it with black. Select the 
Brush tool, set its opacity to 50% and its width to 300 pixels, 
and brush in the area between the two stems. Bring up the 
Fade effect dialog box and reduce the opacity to 38%. View 
the image after brushwork (Figure 4 .6 .28) and the resulting 
layer mask (Figure 4 .6 .29).

12. Duplicate the REDS_DUO layer (the new layer will be 
named REDS_DUO copy2), and move it to the lower right 
corner to the right of the lily stem (Figure 4 .6 .30).

13. Select Free Transform (Command + T / Control + T), and 
holding the Option / Alt key, click on the left control handle 
and expand the size. Click near the lower, left handle which 
will bring up the Rotate arrows and rotate the image slightly 
clockwise to match the angle of the two stems that border this 
selection. Press Return / Enter (Figures 4 .6 .31, 4 .6 .32, and 
4 .6 .33).

Figure 4.6.24 Activating the 
Free Transform tool

Figure 4.6.26 Rotating the 
selection

Figure 4.6.25 Expanding the 
width

Figure 4.6.27

Figure 4.6.28 The image after 
brushwork

Figure 4.6.29 The layer mask
Figure 4.6.30 Adding red below 
the lily
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14. Make the layer mask active and fill it with black. Select the 
Brush tool, set its opacity to 50% and its width to 500 pixels, 
and brush in the area between the two stems. Bring up the 
Fade effect dialog box and reduce the opacity to 38%. View 
the image after the brushwork (Figure 4 .6 .34) and the result-
ing layer mask (Figure 4 .6 .35).

15. Turn on and make the RED_DUO layer active. Move it to 
the lower left corner between the two stems (Figure 4 .6 .36).Figure 4.6.32 Expanding the 

width

Figure 4.6.33 Rotating the 
selection

Figure 4.6.31 Free Transform tool

Figure 4.6.34 After the brushwork Figure 4.6.35 The layer mask

Figure 4.6.36 Adding red to the left side



250          Welcome to Oz 2.0

16. Select Free Transform (Command + T / Control + T), 
and holding down the Option / Alt key, click on the top, 
center control handle and expand the height. Click near the 
lower, left handle to bring up the Rotate arrows and rotate 
the image slightly counterclockwise to match the angle of 
the two stems that border this selection. Holding down the 
Option / Alt key, click on the left, center control handle 
and expand the selection slightly. Press Return / Enter 
(Figures 4 .6 .37, 4 .6 .38, and 4 .6 .39).

17. Make the layer mask active and fill it with black. Select the 
Brush tool, set its opacity to 50% and its width to 500 pixels, 
and brush in the area between the two stems. Bring up the 
Fade effect dialog box and reduce the opacity to 31%. View the 
image after the brushwork (Figure 4 .6 .40) and the resulting 
layer mask (Figure 4 .6 .41).

Figure 4.6.37 Selecting the Free 
Transform tool

Figure 4.6.38 Expanding the 
selection

Figure 4.6.39 Rotating 
the selection

Figure 4.6.40 The image after 
the brushwork

Figure 4.6.41 The layer mask
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The emery Board Step

In this last part of the “inner harvesting” step, you will 
smooth out any places where the transition from sharpness to 
blur occurs more abruptly than you would like. Also, this is a 
good time to increase the colors’ intensities and the lightness 
of the background to further fine tune the image. You will use 
the Base Layer to accomplish all these tasks. Look at the Base 
Lite Brush Back image map (Figure 4 .7 .1).

Figure 4.7.2 The image after 
the brushwork

Figure 4.7.3 The layer mask

Figure 4.7.1 Base Lite Brush 
Back image map

1. Duplicate the BASE_LITE layer and move it so that it is the 
topmost layer in the INNER_HARVEST layer group. Rename 
this layer BASE_LIGHT_BB (BB = Brush Back).

2. Create a layer mask and fill it with black.

3. Make the layer mask active. Select the Brush tool. With 
the foreground color set to white, set the brush opacity to 
50% and its width to 400 pixels. Using the image map dia-
gram as your guide, brush in the lower part of the lily. Bring 
up the Fade effect dialog box and reduce the opacity to 41%. 
Brush in the left stem. Bring up the Fade effect dialog box and 
reduce the opacity to 36%. Brush in the right stem. Bring up 
the Fade effect dialog box and reduce the opacity to 31%. In 
the upper right corner, brush the right-most yellow base of 
the background lily. Bring up the Fade effect dialog box and 
reduce the opacity to 28%. Finally, brush in the lily’s base next 
to where you just brushed. Bring up the Fade effect dialog box 
and reduce the opacity to 31%. Look at the image after the 
brushwork (Figure 4 .7 .2) and the layer mask (Figure 4 .7 .3).

4. Make the INNER_HARVEST layer group active.

5. Create a Master layer and name that layer MASTER_2.

6. Save the file.

7. Select Save As (Command + Shift + S / Control + Shift + 
S), and when the Save As dialog box comes up, rename the 
file SEATTLE_LILY_MASTER_CNTRST_SHRP_16bit. Click off 
the layers radial button and save it in the Large Document file 
format (.psb). 

NoTe: The reason for doing this is that the current file size 
of what you have just done is 2 .1 gigabytes . That is a lot of 
file to have to move . Everything you just did was to create 
one image from many . Every decision that needed to be 
made, has been made . By breaking the image workflow up 
into different files, you save time while preserving an exit 
strategy .
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The Dance of Aesthetics

Directing the unconscious eye
Every act of creation has to start first with an act of destruction.

—Pablo Picasso

As I indicated in the previous chapter, the human eye is an 
amazing biological optical system. But this eye is by no means 
conscious. True, the eye evolved from migrated brain tissue, 
but it does not think. It sees what it sees and does so in a very 
specific, predictable manner. 

But I believe that humans are in possession of another eye, 
the conscious one; the one that gives meaning to what we see. 
The unconscious eye records, while the conscious eye inter-
prets what is recorded.

To this point, you have made decisions on how to manipu-
late an image so that it will speak to the conscious eye of the 
viewer. You have done that by causing the unconscious eye 
to go where you wanted it to go, so that the story would be 
seen the way you determined it should. You did this by using 
the alphabet of the photograph: contrast, saturation, and 
sharpness and by the recognition that the unconscious eye 
first recognizes light areas and then moves to dark ones, sees 
high contrast before low contrast areas, records areas of high 
sharpness before low sharpness, notices areas in focus before 
those that are blurred, and focuses on highly color-saturated 
areas before moving to less-saturated ones. Thus, you over-
rode the tendency of the unconscious eye to wander and sent 
it on a path of your own choosing. 

By controlling the sequence of things that the unconscious 
eye sees is another facet of control by which you cause shape 
to become the unwitting ally of color. Previously, you created 
a pattern interrupted to control the unconscious eye. Now 
you will do that by working from dark-to-light to remove the 
light that does not belong and light-to-dark to add brightness 
where it should be. Also, you will further control the uncon-
scious eye through use of contrast and several forms of “un-
sharp” sharpening.

At this point in the lesson, you realize that the image you 
now have was created from conscious decisions that were 
made at the time of capture. You did not fix this image in 
Photoshop; rather, you used Photoshop to re-create the vision 
that you had at moment of capture using fragments of the 
image itself. No tone mapping software was used to extend 
the exposure’s dynamic range. 

It is at this point in an image’s workflow that you would 
probably do a color cast correction, as you have in the previous 
three chapters. You will not do that for this image, because 
here, the color cast works to your advantage. Remember, the 
cleanest file that exists, the one with the least amount of arti-
facts, is the original RAW file, and a non-destructive workflow 
endeavors to minimize artifacting, as well as assuring an exit 
strategy. The important lesson is that workflow is dynamic 
and image specific. You will never do the same things, and in 
the same order, all of the time. 
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Step 7: Setting Up for Things to Come
1. If you have not already done so, close the SEATTLE_
LILY_16bit.psb file. (If Photoshop asks you if you want you to 
save the file before closing, click OK.)

2. Open the SEATTLE_LILY_MASTER_CNTRST_
SHRP_16bit.psb file.

3. Rename Layer 1 and call it MASTER_BASE.

4. Save the file.

5. Duplicate the file (Image > Duplicate) and name the new 
one SEATTLE_LILY_LAB_SAT_SHARPEN.

6. Convert this file to LAB (Image > Mode > Lab color). 

7. Save the newly created LAB file and leave it open.

8. Make SEATTLE_LILY_MASTER_16bit.psb the active file.

9. Duplicate the MASTER_BASE layer twice.

10. Make the MASTER_BASE copy 2 (the top-most layer in 
the layer stack) into a Smart Filter. Add a layer mask and du-
plicate this layer twice.

11. Create a layer group and name it CONTRST/SHRPN.

12. Inside the layer group that you just made (CONTRST/
SHRPN), create a new layer group and name it CS_SHARPEN. 

13. Drag the MASTER_BASE copy and MASTER_BASE copy 
2 layers into the CS_SHARPEN layer group. (MASTER_BASE 
copy 2 should be the top layer in the layer stack at this time.)

14. Turn off the MASTER_BASE copy 2 layer and make the 
MASTER_BASE copy layer the active one.

15. Save the file. 

Part One: The Dance of Sharpness and Contrast

Step 8: Aesthetic Sharpening Using CS only
As I discussed in Chapter 3, each type of sharpening sharpens 
the image in a slightly different way and each has a benefit. 
By separating your sharpening steps into different layers and 
then using opacity and layer masks to blend them together, 
you get the benefits of the different types of sharpening with-
out the cumulative effect of artifacting.

Sharpening Using the High Pass Filter

In this step, you will selectively enhance sharpness using High 
Pass sharpening. Look at the Image map (Figure 4 .8 .1).

1. Rename the MASTER_BASE copy layer HIGHPASS.

2. De-saturate the HIGHPASS layer (Command + Shift + U / 
Control + Shift + U).

Figure 4.8.1 High Pass Sharpening image 
map
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3. Make the HIGHPASS layer into a Smart Filter and add a 
layer mask.

4. Go to Filter > Other > High Pass.

5. If it is not already there, move the Radius slider all the 
way to the left, or to a radius of 0.1. You should see nothing 
but gray.

6. Move the Radius slider to the right until you start to see 
just the edges of the image structures (in this case the veins in 
the lily) at 13.5 pixels for this image (Figure 4 .8 .2).

7. Click OK and change the HIGHPASS layer blend mode to 
Softlight. Compare the image before High Pass (Figure 4 .8 .3) 
and after High Pass sharpening (Figure 4 .8 .4).

8. Make the layer mask active, fill it with black, select the 
Brush tool, and set its opacity to 100% with a width of 
500 pixels. Brush in the front lily area. View the layer mask 
(Figure 4 .8 .5).

9. Set the brush opacity to 50% and brush in the back part of 
the lily. Then, reduce your brush size to 70 pixels and brush in 
the tip of the lily. View the layer mask (Figure 4 .8 .6).

Figure 4.8.2 High Pass Sharpen-
ing set to a radius of 13.5 pixels

Figure 4.8.3 Before High Pass 
sharpening

Figure 4.8.4 After High Passs 
sharpening

Figure 4.8.7 Figure 4.8.8

Figure 4.8.5 Figure 4.8.6
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10. Set the brush opacity to 50% and the width to 400 pixels, 
and brush in the lower stem of the lily. Bring up the Fade ef-
fect dialog box and reduce the opacity to 34%. Brush in the 
long stem around which the lily tip wraps. Bring up the Fade 
effect dialog box and reduce the opacity to 44%. Brush in 
the lower left corner stem. Bring up the Fade effect dialog 
box and reduce the opacity to 24%. View the resulting layer 
mask (Figure 4 .8 .7) and the image after the brushwork 
(Figure 4 .8 .8).

11. Save the file.

Sharpening in LAB 

1. Make the SEATTLE_LILY_LAB_SAT_SHARPEN.psb file 
the active one.

2. Duplicate the layer, destaturate the layer you just dupli-
cated, name it LAB_SHARP_WORKING, and make it into a 
Smart Filter.

3. Go to Filter > Sharpen and select Smart Sharpen.

4. In the Smart Sharpen dialog box, select Gaussian Blur 
from the Remove pull-down menu, and set the amount to 
500% and the radius to 0.1.

5. Zoom in on the veins of the lily.

6. Now, move the radius first to the desired range of sharp-
ening (2.6 pixels for this image).

7. Lower the amount until you remove the crispiness or 
hardness and the halos around the edges of the image. I chose 
258%.

Figure 4.8.8 Figure 4.8.9

8. Click OK.

9. Do “the Move” and name this layer LAB_SHARPEN. 
Set the layer blend mode to Luminosity. Compare the 
image before (Figure 4 .8 .9) and after LAB sharpening 
(Figure 4 .8 .10).

10. Turn off the LAB_SHARP_WORKING layer.

NoTe: Files save more quickly and open faster if Smart Fil-
ter layers are turned off .

11. Save the file.

12. Holding down the Shift key, drag the LAB_SHARPEN 
layer to the CS_SHARPEN layer set folder (so that it is above 
the HIGHPASS layer) in the SEATTLE_LILY_MASTER_16bit.
psb file. Add a layer mask and fill it with black.

13. Select the Brush tool and set its opacity to 50% and its 
width to 400 pixels. Brush in the sharp area of the lily and 
the back part of the lily including the tip. Do not brush in the 
blurred areas of the lily. View the image map (Figure 4 .8 .11), 
the image after the brushwork (Figure 4 .8 .12), and the layer 
mask after the brushwork (Figure 4 .8 .13).

14. Save the file.

Figure 4.8.11 Figure 4.8.13Figure 4.8.12
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Sharpening Using the Smart Sharpen Lens Blur Filter 

1. Turn on the MASTER_BASE copy2 and make it the ac-
tive layer. Change the blend mode to Luminosity. (This layer 
should be the top layer in the CS_SHARPEN layer set folder.) 
Name this layer SMART_SHARP_LENS.

2. Go to Filter > Sharpen and select Smart Sharpen.

3. In the Smart Sharpen dialog box, select Lens Blur from 
the Remove pull-down menu and set the amount to 500% 
and the radius to 0.1. 

4. Move the radius to 1.7 and the amount to 258%. Click 
OK. 

5. Copy the layer mask from the LAB_SHARP layer.

6. Make a master layer and name it CS_SHARP.

7. Turn off the CS_SHARPEN layer group.

8. Save the file.

Step 8.1: Aesthetic Sharpening Using the Nik 
Software Sharpener Pro 3.0 Filter
These next steps require that you have Nik Software Sharp-
ener Pro 3.0 or that you have downloaded the free 15-day 
demo. For this image, you will use control points to define the 
sharpening. When I use control points for sharpening, I zoom 
in to the area of most importance and use the global sliders to 
get the look I want. Then, I drop the control points to either 
sharpen the areas I want or to define those I do not want 
sharpened. Below is the workflow I employed for this image.

1. Make the MASTER_BASE copy3 layer active, duplicate this 
layer, and name it NIK_SHARPEN.

2. Set the layer blend mode to Luminosity.

3. Place this new layer above the CS_SHARPEN layer. (Set it 
so that it is outside of the layer set.) 

4. Go to Filter > Nik Software > Sharpener Pro 3.0. (2) : Out-
put Sharpening.

5. In the Output method pull-down menu, select Inkjet.

6. For the sharpening type you selected, leave the viewing 
distance set to Auto and the paper dimensions to what comes 
up in the dialog box. You are creating a fine-art print, so select 
Texture & Fine Art. Set the printer resolution to 2880 x1440.

7. Zoom in to the center part of the lily (Figure 4 .9 .1).

8. In the Creative Sharpening dialog box, start with Struc-
ture and move the slider to a little more than you think you 
need. I chose 44%.

9. Next, move the Local Contrast slider to little more than 
you think you need. I chose 21%.

10. Next, move the Focus to little more than you think you 
need. I chose 21%.

11. Zoom out of from the center of the image (Command + 0 / 
Control + 0).

12. Select the Select tool (located next to the Magnify Glass 
tool) in the upper left of the dialog box. Make sure that Selec-
tive Sharpening is checked on and Control Points is selected 
in the pull-down menu (Figure 4 .9 .2).

13. Click on Control Points and find the place in which you 

Figure 4.9.1 Zoomed in on the center of the lily in Sharpener Pro 3.0
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want to drop the control point. (I put this first one in the 
center part of the lily.) When you click, the Control Point is 
placed. Then, click directly on the Control point to make all of 
the handles visible (Figure 4 .9 .3). 

14. Click on the S (Structure) handle and move it to 44%, then 
click on the LC (Local Contrast) handle and move it to 21%, 
and then click on the F (Focus) handle and move it to 21% 
(Figure 4 .9 .4). 

Figure 4.9.2 Selecting Control Points in the Selective Sharpening 
pull-down menu

FIgure 4.9.3 Making the Control Point active

15. Click on Control Points and place the second point. (I 
dropped the second one in the upper right corner on the red 
area between the two stems.) You will see the sharpness that 
was applied from the first control point disappear, but the 
sharpness in the lily remains (Figure 4 .9 .5). 

Figure 4.9.4 Adjusting the sliders for the control point

Figure 4.9.5 Placing the second control point
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16. Click on Control Points and place the third point in the 
lower right corner on the red area between the two stems 
(Figure 4 .9 .6).

17. Click OK. Compare the image before (Figure 4 .9 .7) and 
after (Figure 4 .9 .8).

Figure 4.9.6 Placing the third control point

Figure 4.9.7 Before Figure 4.9.8 After

18. Make the layer mask active and fill it with black. Select 
the Brush tool, and with the foreground color set to white, 
the brush opacity set to 50%, the brush width set to 400 pix-
els, brush in the center part of the lily (using the image map 
diagram as your guide). Leaving the brush opacity set to 50%, 
reduce your brush size to 250 pixels, and brush in the upper 
part and back of the lily. Again, leaving the brush opacity set 
to 50% reduce the brush width to 80 pixels, and brush over 
the flower tip. Increase the brush width to 400 pixels, brush 
in the stem of the lily, bring up the Fade effect dialog box, and 
move the slider to 35%. Brush in the lower stem to the right 
of the lily, bring up the Fade effect dialog box, and move the 
slider to 20%. Brush in the upper stems to the right of the lily, 
bring up the Fade effect dialog box, and move the slider to 
20%. Brush in the long stem to the left of the lily, bring up the 
Fade effect dialog box, and move the slider to 10%. 

Look at how the image evolved by looking at the image 
map (Figure 4 .9 .9) the layer mask after the brushwork 
(Figure 4 .9 .10) the image before brushwork (Figures 4 .9 .11 
and 4 .9 .12), the image after the brushwork (Figures 4 .9 .13 
and 4 .9 .14), and the image after the brushwork is combined 
with the CS_SHARPEN layer (Figures 4 .9 .15 and 4 .9 .16). 

19. Save the file.

NoTe: Because I used a combination of both the Nik Sharp-
ener and CS Sharpen approaches, I put both of those layers 
into a layer group called SHARP_COMBO .
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Figure 4.9.9 The image map

Figures 4.9.11 and 4.9.12 Before brushwork 
and detail

Figures 4.9.13 and 4.9.14 After brushwork 
and detail

Figures 4.9.15 and 4.9.16 After brushwork 
and combined with CS_SHARPEN and detail

Figure 4.9.10 The layer mask



260          Welcome to Oz 2.0

Step 9: Selective Contrast
In this next series of steps, you will create two contrast layers: 
a Tonal Contrast layer and a Contrast Only layer. 

Adding Tonal Contrast with the Nik Software Tonal 
Contrast Filter

1. Create a new layer set (above the NIK_SHARPEN or 
CS_SHARP layer depending on which way you went with the 
aesthetic sharpening of this image) and name this new layer 
set CONTRAST.

2. Turn off the Sharpen layer(s).

3. Drag the MASTER_BASE copy 3 layer into the CON-
TRAST folder. Set this layer to the Luminosity blend mode 
and duplicate it. (This newest layer should be MASTER_
BASE_copy 4.) Name this layer CONTRAST_ONLY and turn 
it off.

4. Make the MASTER_BASE_copy 3 layer active (turn it on 
if it is not already) and rename it TONAL_CONTRAST.

5. Select Filter > Nik Software > Color Efex Pro 3.0 Versace 
Edition. When the Nik Software filter dialog box comes up, 
select Tonal Contrast.

6. If you have not already, select Split view.

7. Zoom in so that you have the upper middle part of the lily 
in the preview screen. 

8. First, set the Mid Contrast slider (I chose +56), and then 
the Shadow slider (I chose +17). Set the Highlight at +29. 
Set both the Protect Shadows and Protect Highlights to 15% 
(Figure 4 .10 .1).

9. Click OK. Compare the image before (Figures 4 .10 .2) and 
after (Figures 4 .10 .3).

10. Select the Brush tool. With the foreground color set to 
white, the brush opacity set to 50%, and the brush width set 
to 400 pixels, brush in the center part of the lily using the 
image map diagram as your guide. Leaving the slider set to 

Figure 4.10.2 Before Figure 4.10.3 After

Figure 4.10.1 Setting the Protect Shadows and Highlights to 15%
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50%, reduce the brush size to 250 pixels, and brush in the 
upper part and back of the lily. Again, leaving the slider set to 
50%, reduce the brush size to 175 pixels, and brush over the 
blurred part of the lily. Bring up the Fade effect dialog box and 
move the slider to 27%. View the image map (Figure 4 .10 .4), 
the resulting layer mask (Figure 4 .10 .5), and the image after 
the brushwork (Figure 4 .10 .6).

11. Lower the layer opacity to 57%.

Adding Contrast Using the Nik Software Contrast 
only Filter

1. Turn on and make the CONTRAST_ONLY layer active.

2. Select Filter > Nik Software > Color Efex Pro 3.0 Versace 
Edition. When the Nik filter dialog box comes up, select Con-
trast Only. Zoom in to approximately the same area that you 
used for the Tonal Contrast adjustments.

3. From the default setting of 50%, move the Brightness 
slider to 40%. Open up the Protect Shadows and Highlights 
dialog box. Set Protect Highlights to 34% and Protect Shad-
ows to 27%. Lower the Contrast to 40%. Lastly, adjust the 
Saturation slider to about 50% (Figure 4 .10 .7).

4. Click OK.

Figure 4.10.4 Image map Figure 4.10.5 Layer mask

Figure 4.10.6 Image after 
brushwork

Figure 4.10.7 Setting the Tonal Contrast sliders
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5. Holding down the Option / Alt key, click on the layer 
mask of the TONAL_CONTRAST layer, and drag it to the CON-
TRAST_ONLY layer.

6. Reduce the opacity to 57%.

7. If they are not already, turn on the sharpen layer group(s) 
and/or layers.

8. Make the CONTRST/SHARPN layer set active.

9. Create a master layer and name it CONTRAST/SHARP.

10. Turn off the CONTRST/SHARPN layer. 

11. Save the file.

12. Go to Save As (Command + Shift + S / Control + Shift + S) 
and, when the dialog box comes up, rename the file SEATTLE_
LILY_MASTER_COLOR_16bit. Click off the Layers radial button 
and save the file in the Large Document file format (.psb).

NoTe: Remember that there is a bit of a dance between 
Contrast Only, Tonal Contrast, and Sharpening . Every image 
is different and, frequently, that difference determines the 
layer order . For this image, it was best to have Sharpening 
beneath Contrast—and to have Contrast Only above Tonal 
Contrast . The reason for this former choice was that when 
Sharpening was beneath Contrast, it minimized the noise 
that sometimes comes with sharpening . I placed Contrast 
Only over Tonal Contrast to further lower the noise and to 
brighten the areas that I wanted the eye to go to first . So 
not only did I help move the way the unconscious eye tracks 
across the image, I enhanced light-to-dark and high-to-low 
contrast just by layer placement .

View the image with the Contrast Only adustment only 
(Figure 4 .10 .8), the image with the Tonal Contrast and 
Contrast Only combined (Figure 4 .10 .9), and the Sharp-
ening, Tonal Contrast, and Contrast Only combined 
(Figure 4 .10 .10). 

Figure 4.10.10 Sharpening, Tonal 
Contrast and Contrast Only

Figure 4.10.8 Contrast Only 
adjustment

Figure 4.10.9 Tonal Contrast and 
Contrast Only
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Step 10: enhancing Warmth 
Using the Nik Software Skylight Filter

1. Close the SEATTLE_LILY_MASTER_CNTRST_SHRP_16bit.
psb.

2. Open the SEATTLE_LILY_MASTER_COLOR_16bit.psb.

3. Rename Layer 1 SHRP/CNTRST_BASE.

4. Duplicate the SHRP/CNTRST_BASE layer and make it into 
a Smart Filter.

5. Add a layer mask.

6. Create a new layer set and name it SKYLGHT/WHT_NTRL/
LABSAT.

7. Drag the SHRP/CNTRST_BASE copy layer into the SKYL-
GHT/WHT_NTRL/LABSAT layer set.

8. Rename this layer SKYLIGHT. 

9. Go to Filter >Nik Software > Color Efex Pro 3.0 Versace 
Edition. Select Skylight from the three plug-in options and 
click OK. For this image, I thought the default of 25% ap-
peared to be the best choice.

10. Change the layer blend mode to Color.

NoTe: The Color blend mode affects only the color of the 
image; it does not change the highlights or the shadows . 
When you last used the Nik Software Skylight filter, you saw 
that the image brightened and the colors warmed when you 
ran the plug-in . When you changed the blend mode to Color, 
the colors did warm up, but the shadows and highlights re-
mained unaffected . 

I generally prefer to switch to the Color blend mode for 
the last step in my process—when I am finished with my ad-
justments to sharpness, color, and contrast . When I use the 
Luminosity blend mode, however, I frequently use it when I 
do an adjustment to sharpness or contrast, because I do not 
want to affect the color of the image . 

11. Select the Brush tool. With the foreground color black, 
set the brush opacity to 50% and its width to 400 pixels, and 
brush in the center part of the stem and the upper part of 
the lily using the image map diagram as your guide. Bring 
up the Fade effect dialog box and move the slider to 24%. 
Now, rebrush the top part of the lily and just left of its yel-
low center. Leave the amount set to 50%, reduce the brush 
size to 250 pixels, and brush in the upper part and back of 
the lily. Bring up the Fade effect dialog box and move the 
slider to 27%. View the image map (Figure 4 .11 .1), the layer 
mask (Figure 4 .11 .2), and the image after the brushwork 
(Figure 4 .11 .3)

Figure 4.11.3 After brushworkFigure 4.11.2 Layer maskFigure 4.11.1 Image map
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Step 11: Neutralizing Whites 
In this step, you will visually neutralize the whites using a Hue 
and Saturation adjustment layer that will specifically target 
the yellows of the image. First, you will reduce the saturation, 
then you will add some blue with the Hue slider, and finally, 
you will lighten everything without removing all the color.

NoTe: Obviously, if there is any color in a white, it is not 
white . This is where having a calibrated monitor is impor-
tant . If you do not have one, what you see on the screen is 
not what you will print .

1. Create a Hue and Saturation adjustment layer and rename 
it NTRLIZE_WHITES.

2. Select Yellows from the Colors pull-down menu 
(Figure 4 .12 .1).

3. Lower the Saturation to –72 (Figure 4 .12 .2).

4. Lower the Hue to –6 (Figure 4 .12 .3).

NoTe: This warms the remaining colors a bit, and will make 
for a smoother transition from the adjusted to the non-
adjusted areas when you do the brushwork on this layer .

5. Increase the Lightness to +6 (Figure 4 .12 .4).

6. Select the Brush tool and fill the layer mask with black. 
With the foreground color white, set the brush opacity to 50% 
and the width to 400 pixels. Using the image map diagram 
as your guide, brush in the center part of the lily, the upper 
blurred part of the lily, and the upper part of the lily to the 
right of the stem that separates the back and front of the lily. 
Bring up the Fade effect dialog box and reduce the amount  
to 19%. Next, rebrush the top of the lily, just to the left of its 
yellow center. Bring up the Fade effect dialog box and reduce 
the amount  to 19%. Just brush the center top and blurred 
background. Bring up the Fade effect dialog box and reduce 
the amount  to 27%. 

7. Leaving the opacity at 50%, reduce the brush size to 250 

Figure 4.12.1 Selecting Yel-
lows from the Colors pull-down

Figure 4.12.2 Lower Saturation 
slider

Figure 4.12.3 Lower Hue slider
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Step 12: Increasing Saturation in the  
LAB Color Space
1. Holding down the Shift key, click and drag the newly 
merged layer (Layer 1) to the SEATTLE_LILY_LAB_SAT_
SHARPEN.psb file. (This file should still be open.) Make sure 
this layer is at the very top of the layer heap.

2. Rename this layer TEMP_COLOR.

3. Create  a Curves adjustment layer and name it LAB_
BOOST. (Make sure that you are in fine grid mode. To do this, 
Option / Alt click on the grid in the Curves dialog box.)

4. Select the “a” channel from the Channel pull-down menu.

5. Click on the top point of the Curve line and move it two 
grid lines left. Then, click on the bottom point on the Curve 
line, and move it two grid lines right (Figure 4 .13 .1).

6. Select the “b” channel from the Channel pull-down menu.

7. Click on the top point of the Curve line and move it one 
grid line left. Then, click on the bottom point of the Curve 
line and move it one grid line right (Figure 4 .13 .2).

pixels, and brush in the upper part and upper blurred back 
of the lily. Bring up the Fade effect dialog box and move the 
slider to 27%. Brush the top and back part (to the left of the 
main stem). Bring up the Fade effect dialog box and move 
the slider to 27%. View the image map (Figure 4 .12 .5), the 
resulting layer mask (Figure 4 .12 .6), and the image after the 
brushwork (Figure 4 .12 .7).

8. Do “the Move.” 

9. Save the file.

Figure 4.12.4 Increasing Light-
ness to +6

Figure 4.12.6 Layer mask

Figure 4.12.5 The image map

Figure 4.12.7 The image after 
the brushwork

Figure 4.13.1 Clipping the “a” 
Curve at the bottom point

Figure 4.13.2 Clipping the “b” 
Curve at the top point
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8. Do “the Move” and rename this layer LAB_SAT.

9. Save the file.

10. Holding down the Shift key, drag the LAB_SAT layer into 
the SKYLGHT/WHT_NTRL/LABSAT layer set.

11. Drag the Layer 1 layer to the trash. 

12. Add a layer mask to the LAB_SAT layer and change the 
blend mode to Color.

13. Fill the layer mask with black.

14. Select the Brush tool. With the foreground color white, set 
the brush opacity to 50% and the width to 400 pixels. Using 
the image map diagram as your guide, brush in the red area in 
the lower, left corner between the two stems. Leave the opac-
ity at 50% and brush in the red area at the lower right corner 
of the image. Bring up the Fade effect dialog box and move 
the slider to 69%. Brush in the red area midway to the right 
corner. Leave the opacity at 50% and brush the red area at the 
top right corner between the two stems. 

15. Brush in the lily stems in the upper, left corner. Bring up 
the Fade effect dialog box and move the slider to 28%. Brush 
in the yellow parts of the area that you just brushed, both at 
50%. Brush the long stem below the front of the flower in the 
lower right corner. Bring up the Fade effect dialog box and 
move the slider to 28%. Brush the stem of the main lily (the 
stem that is at the base of the flower in the bottom middle). 
Leave the opacity at 50% and brush in the upper part of the 
lily next to the stem following the yellow to the base and in-
cluding all of the yellow area in the base. Bring up the Fade 
effect dialog box and move the slider to 17%. Brush just the 
yellow parts of the lily’s base and move the slider to 27%.

16. Reduce your brush to 80 pixels and brush the tip of the 
lily. Bring up the Fade effect dialog box and move the slider to 
77%. Brush in the top part of the lily and leave the opacity at 
50%. 

17. Reduce the layer opacity to 57%.

View the image map for the planned work (Figure 4 .13 .3), 
the resulting layer mask (Figure 4 .13 .4), and the image after 
the brushwork (Figure 4 .13 .5).

Figure 4.13.3 The image map Figure 4.13.4 The layer mask Figure 4.13.5 The image 
after brushwork
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Seeing the Light of Traveling at the Speed of Dark

In my view you cannot claim to have seen something until you have 
photographed it.

—Emile Zola

Everything you have done on your journey through this 
image has been to get to this point—controlling the viewer’s 
eye by the use of isolates (you might want to review the Iso-
late Theory sidebar at the beginning of this chapter). As I 
have discussed in the previous chapters, dark is as important 
to an image as is light. And as you have already seen, there 
is more to adding dark than merely adding dark. How you 
darken an image affects its color. Therefore, the blend modes 
that you choose to use, and where you use Curves adjustment 
layers with regard to the layer stack, become important in the 
creation of the dark aspects of any image. 

What is true for the dark aspects of the image is also true 
for the light ones. You will see, as you create dark-to-light and 
light-to-dark Curves adjustment layers, that how you create 
and place the light aspects of the image are also important.

Just as was the case when you used Curves adjustment 
layers to remove color cast, there is no one Curves adjustment 
layer that will do everything in one swift move. It will take a 
number of steps to create just the right balance of light-to-
dark isolates to take the viewer’s eye on the path you intend.

Step 13: Traveling at the Speed of Dark: Using 
Curves to Create Dark-to-Light Areas

In this step, you will first work on the dark and intermediate 
isolates in the image by using two Curves adjustment layers. 
The final goal that you seek for this image is to cause shape to 
become the unwitting ally of the color yellow, which includes 
the yellow-tinged white areas of the lily as well. Your aim is to 
direct the viewer’s eye in such a way that they first see, and 

remember, the yellow, even though the image is mostly green.
Also, by building the dark-to-light and light-to-dark relation-
ships in the next series of steps, you will add an almost three 
dimensionality to the image by enhancing the warm colors 
(that tend to move forward in a image). Here is the image map 
of the brushwork that you will do (Fig 4 .14 .1).

1. Create a new layer group and name it L2D_D2L.

2. In the L2D_D2L layer group, create a Curves adjustment 
layer.

3. Name this new layer D2L_NORM.

4. Leave the blend mode set to Normal. 

NoTe: You are leaving the blend mode as Normal because, 
when you darken a color, you increase its saturation . You 
will not use the blend mode Multiply because you will need 
more granular control of the darkness than Multiply will 
afford .

Figure 4.14.1 Brushwork image map
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5. Click on the center control point and drag it downward to-
ward the right corner so that it is in the middle of the grid box 
that was to the right of the center point. The output should 
be about 112 and the input be about 140 (Figure 4 .14 .2).

6. Fill the layer mask with black, set the foreground color to 
white, and select the Brush tool. Set the brush opacity to 50% 
and the brush width to 400 pixels. Following the image map, 
brush in the stem in the upper right corner above the main 
lily. Leave the opacity at 50%. Do the same to the stem in the 
upper right corner above the lily that is at the center of the 
image—again leave the opacity at 50%. Brush in the red area 
between the two stems that you have just brushed. Bring up 
the Fade effect dialog box and increase the opacity to 60%. 
Brush in the upper left corner, the area above the left top of 
the lily, and the long stem around which the flower wraps. 
Leave the opacity at 50%.

7. Brush in the stem in the lower right corner that starts be-
neath the main lily. Leave the opacity at 50%. Brush in the red 
area to the left of the stem that you just brushed. Brush right 
up to the lily. Bring up the Fade effect dialog box and increase 
the opacity to 60%. Brush in the red area to the right of the 
lower stem. Bring up the Fade effect dialog box and increase 
the opacity to 60%. Brush in the red area to the left of the lily 
between the two lower left stems. Bring up the Fade effect 
dialog box and increase the opacity to 60%.

8. Brush in the yellow area of the main lily and the lower 
background to the left of the main lily’s stem. Make sure not 
to brush the main lily’s stem. Leave the opacity at 50%. Brush 
the lower edge of the upper part of the lily. Leave the opacity 
at 50%.

Compare the image before the brushwork (Figure 4 .14 .3), 
the resulting layer mask (Figure 4 .14 .4), and after the brush-
work (Figure 4 .14 .5).

9. Duplicate the D2L_NORM Curves adjustment  layer, re-
name it D2L_NORM_2 and fill the layer mask with black. 

Figure 4.14.2 Dragging the center 
point down

Figure 4.14.3 Before brushwork

Figure 4.14.4 The layer mask Figure 4.14.5 The image after the 
brushwork



Chapter Four: The Unwitting Ally 2.0          269

The goal of the next D2L Curves adjustment layer is to both 
deepen the yellow of the lily base (due to the increase of color 
saturation that occurs when you darken an image) and to 
cause the white part of the image to become more prominent 
by increasing the relationship of light-to-dark (part of the 
ABC’s of how the eye sees). This is the image map of the areas 
that you will brush in the D2L_NORM_2 Curves adjustment 
layer (Figure 4 .14 .5).

NoTe: The reason that you are duplicating this Curves 
adjustment layer is first, by simply duplicating the layer, 
you do not need to go through all the work of darkening 
over again (workflow efficiency) and second, you will have 
more granular control . This granular control comes when 
you fill the layer mask with black and do brush work on it . 
In some cases where you have already done brush work on 
the L2D_NORM Curves adjustment layer (that you have just 
duplicated), you will further fine tune the layer’s opacity .

Figure 4.14.5 Image map for 
D2L_NORM_2

You did not duplicate the layer twice after filling the 
layer mask with black in Step 6, because this is what I did 
when I created this image for the first time . You are seeing 
my “thought workflow .” It was after doing the brush work 
on the first L_2_D_NORM Curves adjustment layer that I 
realized that I wanted to apply more targeted “darkness” 
in certain areas . I liked what I had done in the first L_2_D_
NORM Curves adjustment layer, and because I did not want 
to change that, I chose to create a new layer rather than to 
paint more on the existing one.  

10. Making sure that the layer mask is active, set the fore-
ground color to white. Select the Brush tool and set its opacity 
to 50% and its width to 400 pixels. Following the image map, 
brush in the upper right corner, just brushing the lily stem to 
the top of the main lily. Bring up the Fade effect dialog box 
and decrease the opacity to 46%.

11. Brush in just the red area at the bottom right of the stem 
of the main lily. Bring up the Fade effect dialog box and in-
crease the opacity to 62%.

12. Brush in just the red area at the bottom left between the 
two stems to the left of the main lily. Bring up the Fade effect 
dialog box and increase the opacity to 62%.

13. Brush in just the yellow part of the base of the main lily. 
Leave the opacity at 50%.

14. Brush in the stem of the main lily, the yellow part of the 
base of the lily, and to the left of the base stem.

15. Save the file.

Look at the image before (Figure 4 .14 .6), the image after 
brushwork (Figure 4 .14 .7), and the resulting layer mask 
(Figure 4 .14 .8).
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Step 14: Let There Be Light… Isolates
What you did in the last step was to set the stage for the pri-
mary light isolate, to which you want the eye to be drawn, by 
adjusting the supporting dark and intermediate isolates. (See 
the Isolate Theory sidebar at the beginning of this chapter.) 
These supporting isolates will be the areas that allow the eye 
places in which to wander and begin to recognize the subtle 
nuances that support the primary isolate and draws the eye 
to it. To accomplish this you will use three Curves adjustment 
layers, two blend modes, and placement above and below the 
two D2L Curves adjustment layers.

This approach is based on a renaissance painting technique 
called sfumato, which is the intricate mixing of thin layers of 
pigment, glaze, and oil to yield the appearance of lifelike shad-
ows and light. In his work, of which Mona Lisa was a prime 
example of sfumato, Leonardo da Vinci used upwards of 30 
layers of paint with a total thickness of less than 40 microm-
eters, or about half the width of a human hair. You can accom-
plish a similar effect using opacity and blend modes with both 
pixel-based layers, as well as adjustment layers. This approach 
works amazingly well in the creation of realistic looking atmo-
spheric effects, from misty haze to inner glow, which, in addi-
tion to creating a primary light isolate, is the goal of the next 
series of steps.

These are the image maps for the brushwork you will do on 
the three Curves adjustment layers layer masks:

	 u	 L2D_SCREEN (Fig 4 .15 .1) 
	 u	 L2D_SCREEN_2 (Fig 4 .15 .2) 
	 u	 L2D_NORM (Fig 4 .15 .3)

Creating a Glow from Within

1. In the L2D_D2L layer set, create a Curves adjustment 
layer, name it L2D_SCREEN, and place it below the D2L_NORM 
Curves adjustment layer. (Starting from the top, the layer 
order should be L2D_SCREEN, then D2L_NORM, and then 
D2L_NORM_2.) Change the blend mode to Screen and fill the 
layer mask with black.

Figure 4.14.7 After the brushworkFigure 4.14.6 Before the brushwork

Figure 4.14.8 The layer mask
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2. Making sure that the layer mask is active, set the fore-
ground color to white. Select the Brush tool and set its opacity 
to 50% and its width to 400 pixels. Following the image map, 
brush in the lily stem to the top of the main lily. Bring up the 
Fade effect dialog box and decrease the opacity to 22%.

3. Brush in the front part, the upper top, and top left of the 
main lily. Bring up the Fade effect dialog box and increase the 
opacity to 31%.

4. Brush in the lower base and about two-thirds up the front 
part of the main lily. Bring up the Fade effect dialog box and 
increase the opacity to 19%.

5. Lower the L2D_SCREEN layer to an opacity of 82%. View 
the resulting layer mask (Figure 4 .15 .5) and the image after 
the brushwork (Figure 4 .15 .6).

6. In the L2D_D2L layer set, create another Curves adjust-
ment layer, name it L2D_SCREEN_2, and place it above the 
L2D_SCREEN Curves adjustment layer. (Starting from the top, 
the layer order should be L2D_SCREEN, then L2D_SCREEN_2, 
then D2L_NORM, and then D2L_NORM_2.) Change the blend 
mode to Screen and fill the layer mask with black. 

Figure 4.15.1 L2D_SCREEN image 
map

Figure 4.15.3 L2D_NORM 
image map

Figure 4.15.2 L2D_SCREEN_2 
image map

Figure 4.15.5 The layer mask Figure 4.15.6 After brushwork
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8. Brush in just above the lower base at the edge of the yel-
low front part of the main lily. Bring up the Fade effect dialog 
box and increase the opacity to 31%.

9. Lower the L2D_SCREEN_2 layer to an opacity of 33%. View 
the resulting layer mask (Figure 4 .15 .7) and the image after 
the brushwork (Figure 4 .15 .8).

10. In the L2D_D2L layer set, create a Curves adjustment 
layer, name it L2D_NORM, and place it above the D2L_
NORM_2 Curves adjustment layer. (Starting from the top, 
the layer order should be L2D_SCREEN, then D2L_NORM, and 
then D2L_NORM_2 L2D_NORM). Leave the blend mode set to 
Normal.

11. Click on the center control point and drag it upward to-
ward the left, upper corner so that the center control point is 
in the middle of the grid box that was to the left of the center 
point. The output should be about 142 and the input should 
be about 119 (Figure 4 .15 .9).

12. Fill the layer mask with black.

13. Making sure that the layer mask is active, set the fore-
ground color to white. Select the Brush tool and set its opacity 
to 50% and its width to 400 pixels. Following the image map, 
brush in just the center part of the main lily.  Bring up the 
Fade effect dialog box and increase the opacity to 79%.

14. Lower the L2D_SCREEN_2 layer to an opacity of 33%.

15. Make the L2D_D2L layer set active, create a master layer, 
and name it MASTER_FINAL.

16. Turn off all of the layer sets. (This will speed up opening 
and saving because this file contains Smart Filters.) 

17. Save the file.

View the resulting layer mask (Figure 4 .15 .10), and the 
image after the brushwork (Figure 4 .15 .11).

Figure 4.15.9 Tweaking the 
Curves adjustment

7. Making sure that the layer mask is active, set the fore-
ground color to white. Select the Brush tool and set its opac-
ity to 50% and its width to 400 pixels. Following the image 
map, brush in all of the main lily. Bring up the Fade effect 
dialog box and decrease the opacity to 22%.

Figure 4.15.7 Layer mask Figure 4.15.8 After the brushwork
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If you now analyze the color image of the Seattle Lily using 
the Isolate Theory, you can see that all of the elements come 
together to create a composition where the lily (the primary 
isolate) is reinforced and brought to the foreground so that it 
appears to be almost three-dimensional. The subtle appear-
ance of the green stalks and reddish background, rendered as 
dark to intermediate isolates, surround the lily and allow it 
to pop out of the image and start the viewer’s seeing process. 
As the viewer becomes more involved with the image, he/
she begins to see and feel the subtle supporting isolates that 
add to his/her emotional response and appreciation of the 
entire composition—and this is what you set out to do at the 
beginning!

Step 15: Disbanding the Potential Banding  
Issue of Blur
If you make a print and find that areas of high blur exhibit 
a stepping pattern that looks like a topographical map, you 
are seeing banding and possible posterization. Banding has 
a tendency to occur in the very blurry areas of an image, be-
cause the computer is trying to linearize the randomness of 
the blur. There are several ways to address this issue, but the 
quickest one is to add noise to the affected areas. The noise 
breaks up the banding. Generally, you want to use Monochro-
matic Gaussian noise.

The size of the image file determines how much noise to add. 
I have found that the range is between 2 and 8, but as a rule, 
it is better to add as little noise as possible. The smaller the 
file, the less noise you should add. For the purposes of teach-
ing this technique, I am going to have you do this step at 
this point in this image’s workflow rather than doing it after 
sharpening for output, which is when I generally do this. This 
step is best done after output sharpening because the last 
thing you want to sharpen is noise.

1. Make the MASTER_FINAL layer active.

2. Holding the Option / Alt key, create a new layer.

3. In the Name box, type NOISE. Then, from the Mode pull-
down menu, select the blend mode Soft Light, and check 
the Fill with Soft-Light-neutral color (50% gray). Click OK 
(Figure 4 .16 .1).

Figure 4.16.1 Creating a new layer

Figure 4.15.11 After the brushworkFigure 4.15.10 The layer mask
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4. Make the NOISE layer into a Smart Filter.

5. Go to Filter > Noise > Add Noise. In the dialog box, select 
Gaussian Noise and check Monochromatic. (Remember that 
the size of the image file determines how much noise to add.) 
Zoom into a blur problem area and move the noise amount 
slider until any banding issues go away. For this image,  
I chose 6. Click OK (Figure 4 .16 .2). 

NoTe: When you look at the 100ppi version of this file, it 
appears to be much noisier than the original, because the 
amount of noise that you apply to an image is dependent on 
the size of the file . For example, if the file size was 100ppi 
instead of the original file size of 300ppi, the amount of 
noise that that you would apply would be around 2 or 3 . I 
have turned off the NOISE layer in the 100ppi reference file, 
but you should turn it on and play with it to see how adding 
noise works .

6. Add a layer mask to the NOISE layer. For this image, 
leave the layer mask white. Following the image map, set the 
brush width to 400 pixels at an opacity of 100%, and with the 
foreground color set to black, completely brush the main lily. 
Now, brush in the main lily stem, bring up the Fade effect dia-
log box, and reduce the opacity to 50%.

7. Lower the NOISE layer to an opacity of 86%.

8. Save the file.

View the image map (Figure 4 .16 .3), the resulting layer 
mask (Figure 4 .16 .4), and the image after the brushwork 
(Figure 4 .16 .5).

Figure 4.16.3 The image map Figure 4.16.4 The layer mask

Figure 4.16.5 The image detail 
after the brushwork

Figure 4.16.2 Adding noise to the image
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Children Play, They Don’t 
Take Notes. Adults Take Notes 
and Don’t Play as Much as 
They Should. 
I hope you are now convinced that there is more to dynamic 
range than just bracketing your exposures. I also hope that 
you have found that there is a much bigger high to be had 
by exploring and exploiting the power and subtlety of image 
harvesting for the purpose of extending the dynamic range 
of all aspects of an image. You have also had a master class in 
directing the viewer’s unconscious eye.

I believe that once you understand how to control color, you 
will have complete mastery of the images that you create. I 
also believe that you have to learn the rules before you can 
effectively break them. But if you make all of this a game, the 
playfulness and spontaneity that you bring to the process will 
be inherent in the image. It is from this sort of spontaneity 
that the truth of your experience will be captured.

Figure 4.0.2 Final image

Figure 4.0.1 Initial image
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Index

2% consideration, 22–23
3D tilt option, 66
8-bit images, 76, 156, 220
16-bit images, 8, 180
50% Gray option, 123
80/20 Rule, 36
0521 Rule, 36

A

Acme Educational, 4
actions, Photoshop, 277
Adams, Ansel, 8, 26, 276, 280
Add Noise filter, 274
Additive Control Point, 53, 55
adjustment commands, 28
adjustment layers
 adjustment commands vs., 28
 Hue and Saturation, 41–43, 110- 
  111, 264–265
 Make Adjustment Layer icon, 147
 Photo Filters, 112–114
 reason for duplicating, 269
 Threshold, 19, 20–22, 198
 See also Curves adjustment layers
Adjustments panel, 112, 147
Adobe RGB color space, 8, 9
aesthetic choices, 232
aesthetic sharpening, 253–259
 High Pass filter for, 253–255
 Lab color mode for, 255
 Sharpener Pro 3.0 filter for,  
  256–259
 Smart Sharpen Lens Blur filter for,  
  256

Albers, Joseph, 226
aligning images, 186–189
 automatically, 187–189, 235–236
 manually, 186–187
 registering and, 242
All Channels View, 195
Ambience slider, 79, 84, 91, 98
angle of view, 59
antennae, FocusBug, 66
Aperture panel, 63, 133
Apply last filter command, 144
ArcaSwiss mount, 182
Aristotle, 13
artifacts
 bit depth and, 76
 correcting, 100
 description of, 22, 100
 layers and, 206
 minimizing, 22–23, 180
 pixels and, 236
 sharpening and, 212, 214
atmospheric effects, 162
Auto Align Layers feature, 186, 187– 
 189, 235–236

B

background color, 32, 33
background lights, 89–97
 brushing in, 94–97
 creating, 89–94
backgrounds
 composite images and, 195–198
 coolness added to, 113
 warmth added to, 113–114

banding problems, 273–274
base images
 copying multiple images on, 183
 removing unwanted elements  
  from, 184–185
Bauer, Peter, 37
believable improbability, 13–14
believable probability, 14
bit depth
 artifacts and, 76
 converting, 76–77, 156, 220
Bjork, xiii
black eyedropper, 25, 124, 198
black layer masks, 47, 155
Black Point Curves adjustment layer
 creating, 25–27
 eyedropper settings, 198
 fine-tuning, 32–34, 124
black points
 adjusting, 26, 32–34
 finding, 19, 20, 122
Blair, John, 59
blend modes, 44
 Color, 202, 263
 Difference, 123, 186–187, 190
 Luminosity, 73–74, 150–152, 203,  
  205, 212
 Multiply, 216–218
 Normal, 73, 186, 194, 267
 Overlay, 153
 Screen, 154–155, 218–220,  
  270–271
 Soft Light, 153–154
blown-out areas, 100
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blue color cast, 46–49, 202
Blue Photo Filter, 112–113
blur
 banding of, 273–274
 comparison of, 62
 contrast vs., 132
 creating lens, 63–71
 depth of field and, 58
 Gaussian, 170, 255
 lens design and, 60–61
 motion of, 64, 68
 Planar, 132, 135–136
 quality of, 45, 58, 60–62
 removing, 212, 213
 Round, 132, 133–134
Blur panel, 64
board-to-board reflecting, 120, 129
bokeh
 comparison of, 62
 concept of, 45
 depth of field and, 60
 lens design and, 60–61
Braque, Georges, 279
Brightness slider, 50, 140, 205
Brightness/Contrast sliders, 206
Brush tool, 32, 38
brushes
 feathered, 126
 opacity setting, 33, 48
 sizing/resizing, 32
brushwork
 background light, 94–97
 blend mode, 153–156
 blur layer, 136–138

 color cast, 201
 Curves adjustment layer, 126–128
 darkening effect, 98–99, 236–238
 dark-to-light, 148, 216–218,  
  267–270
 key light, 85–86, 88, 163
 light-to-dark, 150–152, 218–220,  
  270–273
 noise layer, 274
 opacity calculations, 137
 Render Lighting Effects, 222
 selective sharpening, 209–210
 Skylight filter, 143
 smoothing out images, 251
 Tonal Contrast, 167–169
butterfly lighting, 120
butterfly shadow, 170–172

C

Cades Cove images, 230, 231
cameras
 human eye compared to, 178
 power and limitations of, 277
 sensor color cast from, 19, 122
 SLR vs. view, 130–131
canvas size, 44
Caponigro, John Paul, 33, 179, 277
carbon fiber tripods, 182
Cartier-Bresson, Henri, 280
Cates, Challen, 4
CCD/CMOS color cast, 19, 122
Center Point of Rotation, 104–105

Changing Document Profile dialog 
  box, 76
channels
 Lab color space, 212, 216, 265
 modifying individual, 26–28, 124
chromatic induction, 14
cinematic approach, xiv–xv
circle of confusion, 58, 59
Clarity tool, 165
Clarke, Arthur C., xi
clipped curves, 150–152, 241–242
Clone Stamp tool, 184
CMOS color cast, 19, 122
color
 adding to lights, 157, 159–160
 background, 32, 33
 cool vs. warm, 113–114
 correcting for eyes, 109–110
 fine-tuning, 164
 foreground, 32, 33
 inner-harvesting, 246–250
 matching, 195, 234–235
 shape and, 226, 227
 sharpening by, 208
Color blend mode, 202, 263
color cast
 composite images and, 198–199
 correcting, 19–28, 46–49,  
  198–199
 digital cameras and, 19, 122
 removing from images, 19, 24–28,  
  122, 124–125, 202
 selectively using, 29–31, 200–201
 thoughts about, 23
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color channels
 Lab color space, 212, 216
 modifying individual, 26–28, 124
Color Efex Pro, 52
Color Picker, 25, 79, 159
Color Settings dialog box, 12
color space
 converting, 76–77, 156, 157, 253
 setting in Photoshop, 12
 three types of RGB, 8, 9
 turning on warnings for, 12
composite image creation, 183–202
 adding background details,  
  195–197
 aligning images, 186–189, 235– 
  236, 242
 color cast removal, 198–199, 202
 color matching process, 195,  
  234–235
 combining multiple images, 183,  
  233
 image map creation, 199–200
 removing unwanted elements,  
  184–185
 selective use of color cast,  
  200–201
 swapping image elements,  
  190–194
 See also image harvesting
composition
 cropping vs., xv
 Isolate Theory of, 229
confusion, circle of, 58, 59
conscious eye, xiv, 16, 252, 276
Content-Aware Fill, 184–185, 242
Content-Aware Spot Healing, 242
contrast
 adding, 205–206, 261–262

 adjusting, 50
 artifacts and, 206
 blur vs., 132
 contrast ratio vs., 203
 described, 45, 153, 203
 diminishing, 150
 enhancing, 153–156
 optical lens, 139–142
 selective, 49–57, 153–156, 203– 
  204, 260–262
 sharpness and, 45, 203, 262
 tonal, 165–169, 260–261
Contrast Only filter, 45–57, 139–140,  
 205–206, 261–262
contrast ratio, 203
Contrast slider, 50, 139
Control Points
 function of, 54
 types of, 53, 55–56
conversions
 bit depth, 76–77, 156, 220
 color space, 76–77, 156, 157, 253
Convert to Profile dialog box, 76
coolness
 adding to backgrounds, 113
 adding to shadow areas, 172–173
copying
 layer masks, 204
 shift-click method of, 183
Craik-O’Brien-Cornsweet Edge  
 illusion, 203
Create a New Group icon, 24, 25, 142
Creative Sharpening dialog box, 208,  
 256
Crop tool, 242
cropping images
 aligning and, 242
 composing vs., xv

Cross, Dave, 123
Curves adjustment layers
 Black Point, 25–27, 32–34, 124
 blend modes and, 153–156
 clipped curves in, 150–152,  
  241–242
 color cast adjustments, 24–28,  
  30–34, 38–41, 124–125,  
  199
 contrast adjustments, 206
 dark-to-light, 145–148, 153–154,  
  216–218, 267–270
 duplicating, 269
 fine-tuning, 125–128
 Hue/Saturation, 41–43
 light-to-dark, 72–76, 150–152,  
  154–155, 218–220,  
  270–273
 Midpoint, 28, 41
 White Point, 27, 38–41
custom workspace, 10–12

D

dark isolates, 229
darkening layers, 98–99, 236–238
dark-to-light adjustments, 145–148, 
  216–218, 267–270
Decker, Lane H., 177
depth of field
 bokeh and, 60
 creating illusion of, 46–71
 dynamic range of focus and, 185
 explanation of, 18, 58
 focal length and, 59–60
 image map of, 17, 19
 optical rule for, 58
 Photo Filters and, 112–114
 selective, 58–71, 132–144
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Destination Profile list, 76
Difference blend mode, 123, 186– 
 187, 190
digital cameras
 human eye compared to, 178
 power and limitations of, 277
 sensor color cast from, 19, 122
 SLR vs. view, 130–131
directional light, 78
distortion problems
 face widening corrections,  
  102–104
 nose size corrections, 104–105
drawing selections, 102, 188, 190
drop shadows, 114–116
duChemin, David, 281
duplicating
 image files, 212
 layers, 46, 139, 196, 269
dynamic range
 depth of field and, 185
 importance of expanding, 179
dynamic workflow, xv, 6–7, 252, 276

E

edges
 feathering in FocalPoint, 63
 increasing contrast at, 203
Einstein, Albert, 24
Elfont, CJ, 226, 229, 276
environmental portraits, 121
Epson printers, 11
Erwitt, Elliott, 280
Essentials workspace, 10
Exhibition Fine Art paper, 11
exposure range, 179
Exposure slider, 79, 84, 91

Extended Dynamic Range (ExDR) 
  images, 179, 226
 See also image harvesting
eye retouching
 correcting eye color, 109–110
 increasing the size of eyes, 106
 making eyes even on face,  
  106–108
 removing red from eyes, 41–43
 See also human eye
Eyedropper tool, 20–21

F

facial corrections
 evening out eyes, 106–108
 eye color corrections, 109–110
 face size adjustments, 102–103
 image maps used for, 102
 lens distortion and, 102–105
 nose adjustments, 104–105
 skin tone adjustments, 110–111
Fade effect command, 32, 33
feathered brushes, 126
feathering
 edges, 63
 selections, 115
files
saving and naming, 44
size considerations, 232, 233, 251
Film Grain panel, 65
filters
 Add Noise, 274
 Contrast Only, 45–57, 139–140,  
  205–206, 261–262
 Gaussian Blur, 170, 255
 High Pass, 210–211, 253–255
 Nik Software, 14, 45, 207

 Photo, 112–114, 173
 Render Lighting Effects, 77–79
 Sharpener Pro 3.0, 207–210,  
  256–259
 Skylight, 45, 46–49, 142–144,  
  202, 263
 Smart, 46, 71, 80, 115, 139
 Smart Sharpen, 212, 213–214
 Tonal Contrast, 165–169, 203– 
  204, 260–261
flattening images, 43
flipping layers, 246
focal length, 59–60
focal point, 59
FocalPoint 2.0 plug-in, 14, 63–71,  
 133
focus
 extending dynamic range of,  
  185–189
 human eye’s capability to, 178
Focus slider, 208, 256
FocusBug tool, 63, 64, 65–71,  
 133–136
focusing light, 78, 90, 96
foreground color, 32, 33
Free Transform box
 composite images and, 191–193
 face adjustments using, 102–108
 lens distortion corrections,  
  102–105
 nose shadow creation and,  
  171–172
 Reference Point in, 104–105
 Smart Filters and, 115
 uniformly expanding/shrinking,  
  103
 Warp tool and, 192–193
Full Screen with Menu Bar mode, 183
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G

Gaussian Blur filter, 170, 255
Gaussian Blur Removal option, 212,  
 213, 255
Gaussian noise option, 274
Genuine Fractal files, 44
gesture, 227
Gitzo tripods, 182
glamour photographs, 120, 174
Gloss slider, 78, 83, 84, 90
Glossary of Digital Photography, The 
 (Blair), 59
granular control, 269
gray-point eyedropper, 28
gridlines, 73
grouping
 layers, 142, 253
 Smart Filters, 71
grunge look, 167, 179
guide grid, 64

H

Haas, Ernst, 226, 230, 279
harvesting images. See image 
harvesting
HDR Efex Pro, 179
head creep, 182
Hearing the Whisper of the Green 
  Fairy, 178
He-Man Sharpening approach, 212,  
 213
High Dynamic Range (HDR) images
 overuse/misuse of, 179
 See also image harvesting
High Pass filter, 210–211, 253–255
Highlight slider, 203, 260

highlights
 controlling contrast of, 166
 increasing specular, 129
 protecting, 52, 260
Histogram palette, 195
History Log, 11
History palette, 197
Holbert, R. Mac, 6, 165
Horace, 277
Hue and Saturation adjustment layer
 neutralizing whites with, 264–265
 removing redness from eyes with,  
  41–43
 skin tone adjustments with,  
  110–111
Hue slider, 264
human eye
 capabilities of, 178
 conscious, xiv, 16, 252, 276
 digital camera compared to, 178
 tracking patterns of, 203
 unconscious, xiv, 16, 132, 145,  
  252, 276
 See also eye retouching
Hurrell, George, 120, 174

I

image harvesting, 178–223
 aligning images, 186–189, 235– 
  236, 242
 clipped curve adjustments,  
  241–242
 color cast adjustments, 198–199,  
  200–202
 color matching process, 195,  
  234–235

 composite image creation, 183– 
  202, 233
 considerations and choices, 232
 contrast adjustments, 203–206,  
  260–262
 dark-to-light adjustments, 216– 
  218, 267–270
 enhancing image warmth,  
  263–264
 explanatory overview, 182
 image map creation, 199–200
 inner-harvesting process, 243–251
 Lab saturation adjustments, 215– 
  216, 265–266
 lightening parts of images,  
  238–241
 light-to-dark adjustments, 218– 
  220, 270–273
 neutralizing whites, 264–265
 noise added to images, 273–274
 recreating human vision through,  
  178–181
 registration problem, 242
 Render Lighting Effects, 220–222
 selective darkening/lightening,  
  236–241
 sharpening process, 207–215,  
  239–241, 253–259
 software available for, 179
 swapping image elements,  
  190–194
 unwanted element removal,  
  184–185
 workflow for, 180–181
image maps, 13–15
 brushwork and, 95
 composite image, 199–200
 creating, 14–15, 122
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 dark-to-light, 145–146
 depth of field, 17
 explanation of, 13–14
 facial corrections and, 102
 importance of using, 101–102
 Lighting, 16–17, 45, 85
 light-to-dark, 16, 45
 percentages used in, 126
 Planar blur, 132
 Round blur, 132
 Screen, 155
 Soft Light, 153
 source files containing, 6
 video tutorial on, 13, 14
images
 8-bit, 76, 156, 220
 16-bit, 8, 180
 aligning, 186–189, 235–236, 242
 analyzing, 122
 composite, 183–202
 duplicating, 212
 flattening, 43
 key components of, 277
 pin registering, 183
 post-shot manipulation of, 279
 registration issues, 242
 removing elements from, 184–185
 sharpening, 207–215
 swapping elements in, 190–194
 visualizing, xiv, 276
improbable believability, 13–14
Induro tripods, 182
inkjet printers, 8, 11, 58
inner-harvesting process, 243–251
 adding specific colors in, 246–250
 overview of steps in, 243–246
 smoothing out images in, 251

intensity
 of color, 235
 of light, 78, 86, 90, 98
Intensity slider, 82, 86, 90, 98, 159
Interface settings, 11
interpolation process, 207
interrupted patterns, 226–227, 243
Inverse command, 141
inverting selections, 141
Isolate Theory, 229, 267, 270, 273,  
 276

K

key lights, 80–88
 adjusting, 82–84, 86–87
 brushing in, 85–86, 88, 163
 opacity settings, 88
 placing, 80–82
keyboard shortcuts
 brush opacity changes, 36, 48
 brush size adjustments, 15
 Brush tool selection, 32
 channel adjustments, 26, 27
 Fade Effect tool, 32
 foreground/background color, 32,  
  33
 Full Screen mode, 183
 Marquee tool, 102
 mask view, 68, 134
 Move tool, 104
 Polygonal Lasso tool, 37
Krause, Kai, 233

L

L brackets, 182
Lab color space
 converting images to, 253

 description of channels in, 216
 increasing saturation in, 215–216,  
  265–266
 sharpening images in, 212–213,  
  255
Lange, Dorothea, 101
Lasso tools, 184
layer masks
 black, 47, 155
 copying, 204
 creating, 47
 error-free, 34–35, 37
 opacity setting, 33, 74
 Planar blur, 138
 Round blur, 136–137
 rules for working with, 36
 sharpening with, 208–210
 unmasking, 36, 94
 window arrangement, 36
layer sets
 activating, 43
 creating/naming, 15, 71
 turning off, 156
layers
 artifacts and, 206
 auto-aligning, 186, 187–189,  
  235–236
 darkening, 98–99, 236–238
 duplicating, 46, 139, 196
 flipping, 246
 grouping, 142, 253
 lighting, 80–97
 master, 71, 139
 merging, 43–44
 naming/renaming, 15, 73
 placement of, 188
 rotating, 196
 sharpening using, 214, 215
 Smart Filter, 46, 139
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Lens Blur, Smart Sharpen, 213–214,  
 256
lens distortion
 facial widening due to, 102–104
 nose size issues and, 104–105
lenses
 bokeh produced by, 60–61
 correcting distortion from,  
  102–105
 depth of field of, 59–60
 perspective correcting, 130
 tilt shift, 130
Leonardo da Vinci, 270
light
 background, 89–97
 color of, 157, 159–160, 164
 directional, 78
 focusing, 78, 90, 96
 intensity of, 78, 86, 90, 98, 161
 key, 80–88
 long, 129
 objectifying, 227
 omni-directional, 78
 placing, 80–82, 156–165
 quality of, 161–162
 reflected sunlight, 120–121, 145
 repositioning, 93
 shadows and, 114
 size adjustments, 160
 spotlight, 78
light bulb icon, 91, 92, 94
Light Color box, 79
light isolates, 229
lighting adjustments
 background lights, 89–97
 blend modes and, 153–155
 dark-to-light, 145–148, 216–218,  
  267–270
 key lights, 80–88

 light-to-dark, 16, 72–76, 150–152,  
  218–220, 270–273
 placing lights, 80–82
 See also Render Lighting Effects 
  filter
Lighting image map, 16–17, 45, 85
Lightness slider
 FocalPoint adjustment, 64
 Hue/Saturation adjustment, 42,  
  111, 264
light-to-dark adjustments, 16, 72–76,  
 150–152, 218–220, 270–273
light-to-dark (L2D) image map, 16,  
 45, 74
LiteDisc reflectors, 129
Local Contrast slider, 208, 256
Lombardi, Vince, 3
long light, 129
LSC algorithm, 166
Luminosity blend mode, 73–74, 150– 
 152, 203, 205, 212

M

Mac OS user interface, 158
Magnetic Lasso tool, 184
Magnusson, Eric, xiv
Maisel, Jay, 225, 226, 227, 279
Make Adjustment Layer icon, 147
marching-ants border, 170
Margulis, Dan, 212
Marquee tool, 102, 104, 106, 188,  
 190
Mask View, FocusBug, 66
master layer, 71, 139
Match Color adjustments, 195,  
 234–235
Material slider, 79, 83, 90
Matisse, Henri, 227

Matte effect, 78
McHugh, Sean, 58, 59
Merge Stamp Visible, 43, 197
merging layers, 43–44
Merklinger, Harold, 61
Metallic effect, 79, 83
Michelangelo, 145
Mid Contrast slider, 260
Midpoint Curves adjustment layer,  
 28, 41
Midpoint slider, 64
midpoints
 adjusting, 28
 finding, 21–22, 23, 123–124
midtones
 controlling contrast of, 166
 selectively increasing, 165,  
  167–169
Mies van der Rohe, Ludwig, 178
Miller, Arthur, 279
Mona Lisa (painting), 270
Monochromatic Gaussian noise, 273,  
 274
motion blur, 182
Motion slider, 64

“The Move,” 43–44, 197
Move tool, 32, 104, 186
Multiply blend mode, 216–218

N

naming/renaming
 files, 44, 251
 layers, 15, 73
natural light, 120–121
Navigator panel, 63
Negative eyedropper, 111
neutralizing whites, 264–265
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New Document preset, 12
Nik Software filters, 14
 Contrast Only, 45, 49–57, 139– 
  140, 205–206, 261–262
 downloading, 14, 46, 207
 Sharpener Pro 3.0, 207–210,  
  256–259
 Skylight, 45, 46–49, 142–144,  
  202, 263
 Tonal Contrast, 165–169, 203– 
  204, 260–261
noise
 adding, 273–274
 minimizing, 207, 262
non-destructive workflow, 8, 10–12
Normal blend mode, 73, 186, 194,  
 267
nose retouching
 butterfly nose shadow, 170–172
 size adjustments, 104–105

O

object-to-sensor-plane relationship,  
 182
omni-directional light, 78
onOne Software, Focal Point 2.0, 14,  
 63–71, 133
opacity
 adjustment layer, 128, 152
 brushwork, 137
 FocusBug, 66
 layer mask, 33, 74
 lens blur, 63–64
 shadow, 116
Open Documents as Tabs option, 11
optical lens contrast, 139–142
output sharpening, 207–208, 256
Overlay blend mode, 153

P

palette, resetting, 133
paper for prints, 11, 208
PatchMatch algorithm, 242
patterns
 interrupted, 226–227, 243
 as shapes, 226
PDF downloads, 277
Pen tool, 200
pen-based system, 6, 13
perfect practice, 4, 7, 117, 276
perspective correcting (PC) lenses,  
 130
Peter, Laurence J., 13
Photo Filters, 112–114, 173
Photoflex Silver reflector, 129
photographs
 key components of, 277
 post-shot manipulation of, 279
 See also images
photography
 cinematic approach to, xiv–xv
 importance of vision in, 279
Photomatix software, 179
Photoshop
 file format, 44
 image harvesting process, 179,  
  180–181
 Photo Filters, 112–114
 preemptive use of, 180, 232
 preferences, 10–11
 principles of using, xiv, 276
 sharpening methods, 210–215
 workflow in, 8, 180
Photoshop CS2: Up to Speed 
 (Willmore), 190
Photoshop LAB Color (Margulis), 212
Picasso, Pablo, 223, 226, 252
pin registering images, 183

pixels
 artifacts and modification of, 236
 real vs. computer-generated, 232
placing lights, 80–82, 156–165
Planar blur
 creating, 135–136
 image map for, 132
 layer masks for, 138
Plastic effect, 79, 83
playfulness, 275
plug-ins, 6
Poetics (Aristotle), 13
Polygonal Lasso tool, 115, 170, 184
portraits, environmental, 121
Positive eyedropper, 110
posterization, 273
power of 50% approach, 33
Pratchett, Sir Terry, 98
preemptive Photoshop, 180, 232
Preferences dialog box, 10–11
presets
 lighting, 78
 New Document, 12
 Wacom tablet, 277
 workspace, 10
Presets panel, 64
printers, 8, 11, 58, 276
ProPhoto RGB color space, 8, 9, 14,  
 180
Protect Highlights slider, 52, 260
Protect Shadows slider, 51, 52, 140,  
 205, 260
.psb files, 233
.psd files, 44
pseudo-HDR grunge look, 167, 179
PS_IMAGE_TEXT folder, 10
Puppet Warp tool, 190
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Q

Quick Mask view mode, 209, 210

R

Radius slider, 211, 254
rasterizing images, 156
RAW images, 19
ray of sunlight effect, 220–222
Reference Point, 104–105
reflected sunlight, 120–121, 145
reflectors, 129
registration problem, 242
Reichmann, Michael, 58, 60
renaming. See naming/renaming
Render Lighting Effects filter, 77
 background lights, 89–97
 bit depth limitation, 220
 darkening effects, 98–99
 dialog box options, 78–79
 key lights, 80–88
 placing lights with, 80–82,  
  156–164
 ray of sunlight effect, 220–222
 zooming the UI of, 158
resizing. See sizing/resizing
resolution setting, 11, 208
RGB color space
 comparing three varieties of, 8, 9
 modifying individual channels in,  
  26–28, 124
RGB formula, xiv, 276
Rockwell, Ken, 61
rotating
 layers, 196
 selections, 248
Round blur
 creating, 133–134

 image map for, 132
 layer masks for, 136–137
ruddiness removal, 110–111
Rulers option, 104

S

saturation
 adjusting, 42, 50, 264
 color intensity and, 235
 increasing in Lab space, 215–216,  
  265–266
 Tonal Contrast and, 166
Saturation slider
 Contrast Only adjustment, 50,  
  140, 205
 Hue/Saturation adjustment, 42
saving files, 44, 251, 255
Scheimpflug principle, 131
Screen blend mode, 154–155, 218– 
 220, 270–271
Seattle Sequence series, 227–229,  
 233
selections
 drawing, 102, 188, 190
 feathering, 115
 inverting, 141
 rotating, 248
selective adjustments
 color cast, 29–31, 200–201
 contrast, 49–57, 153–156, 203– 
  204, 260–262
 darkening/lightening, 236–241
 depth of field, 58–71, 132–144
 sharpening, 207–215
sensor color cast, 19, 122
sfumato technique, 270
Shadow slider, 203, 260

shadows
 butterfly, 170–172
 contrast of, 165, 166, 167–169
 coolness added to, 172–173
 creating realistic, 114–116,  
  170–172
 protecting, 52, 140, 205, 260
shapes
 colors and, 226, 227
 patterns as, 226
Sharpener Pro 3.0 filter, 207–210,  
 256–259
sharpening, 207–215
 aesthetic, 253–259
 artifacts from, 212, 214
 High Pass, 210–211, 253–255
 how it works, 203
 Lab space, 212, 255
 layers used for, 214, 215
 lightness/darkness, 239–241
 Nik Software filter for, 207–210
 Photoshop methods for, 210–215
 problems related to, 207
 selective, 207–215
 Sharpener Pro 3.0 filter for, 207– 
  210, 256–259
 Smart Sharpen Lens Blur, 213– 
  214, 256
sharpness
 contrast and, 45, 203, 262
 Unsharp Masking and, 203
Shibumi, 7, 117
shift movements, 131
Shift-click method, 183
Shinseki, Eric, 179
Shiny effect, 78
sizing/resizing
 brushes, 32
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 lights, 160
skin tone adjustments, 110–111
Skylight filter, 45, 46–49
 color cast correction, 46, 202
 selective warmth adjustment,  
  142–144, 263
SLR vs. view cameras, 130–131
SLR sensor color cast. See color cast
Smart Filters
 converting layers to, 46, 139
 Free Transform and, 115
 grouping into layer sets, 71
 lighting adjustments and, 80, 85,  
  86–87
 turning off layers with, 156, 255
Smart Sharpen filter
 Gaussian Blur Removal option,  
  212, 255
 Lens Blur option, 213–214, 256
Smith, W. Eugene, 119
smoothing out images, 251
Snap to Guides setting, 183
Soft Light blend mode, 153–154
Soft Omni effect, 80, 89, 98, 159– 
 160, 221
Soft Spotlight effect, 80, 89
specular highlights, 129
split view screen, 140, 167, 203
Spolin, Viola, 22
spontaneity, xiv, 275
Spot Healing brush, 184, 242, 247
spotlight effect, 78
sRGB color space, 8, 9
Standard Lasso tool, 184
standards, camera, 130
Stardust image, 120–121, 129
still photographs, xiv, 276
.stn files, 44

Subtractive Control Point, 53, 55–56
summary of key points, 276–277
sunlight
 adding rays of, 220–222
 color cast from, 122
 reflected, 120–121, 145
swing movements, 131

T

tablet-based system, 6, 13
telephoto lenses, 59
textured black/white, 26
Threshold adjustment layers, 19
 discarding, 22, 24
 finding sample points using, 20– 
  22, 23, 198
.tif files, 44
tilt movements, 131
tilt shift (TS) lenses, 130
time component, 277
tonal contrast, 165–169
explanation of, 166
midtones and, 165, 167–169
selective, 203–204, 260–261
Tonal Contrast filter, 165–169, 203– 
 204, 260–261
toolbar, FocalPoint, 65
tools
 Brush, 32, 38
 Clarity, 165
 Clone Stamp, 184
 Crop, 242
 Eyedropper, 20–21
 Lasso, 184
 Magnetic Lasso, 184
 Marquee, 102, 104, 106, 188, 190
 Move, 32, 104, 186

 Pen, 200
 Polygonal Lasso, 115, 170, 184
 Puppet Warp, 190
 Vibrance, 109–110
 Warp, 115, 171, 190, 192–193
 Zoom, 20
Trash Can icon, 22, 23
tripod heads, 182
tripods, 182
TrueLight function, 52
tutorials. See video tutorials

U

U Point Pixel Characteristics, 54
unconscious eye, xiv, 16, 132, 145,  
 252, 276
Units & Rulers setting, 11
Unsharp Masking, 203, 207

V

Vibrance tool, 109–110
video tutorials
 of complete book, 4
 on layer masks, 34
 on making image maps, 13, 14
 on skin tone adjustments,  
  110–111
view vs. SLR cameras, 130–131
viewing mode, 183
Vignette panel, 64
visualizing images, xiv, 276



292          Welcome to Oz 2.0

W

Wacom tablets, 6, 44
warm colors
 added to backgrounds, 113–114
 enhancing in images, 263–264
 selectively adding, 142–144
warnings
 color space, 12
 Smart Filters, 115
Warp tool, 115, 171, 190, 192–193
Web resources
 acmeeducational.com, 4
 niksoftware.com, 14, 207
 ononesoftware.com, 14
 welcome2oz.com, 5, 13
 See also video tutorials
welcome2oz.com website, 5, 13
White, Minor, 26
white eyedropper, 27, 124
White Point Curves adjustment layer
 creating, 27
 fine-tuning, 38–41
white points
 adjusting, 27, 38–41
 finding, 19, 20–21, 122
whites, neutralizing, 264–265
The Why to of My How PDF download, 
 277
Willmore, Ben, 190
windows, arranging, 36, 171
Windows 7 user interface, 158
workflow
 dynamic, xv, 6–7, 252, 276
 image harvesting, 180–181
 layer mask, 34–35
 non-destructive, 8, 10–12
 Photoshop setup and, 8, 180

workspaces
 custom, 10–12
 preset, 10

X

XDR images, 179

Y

YouTube videos, 14, 110

Z

Zola, Emile, 267
Zone system, 26
zoom lenses, 61
Zoom tool, 20
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